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Introduction
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Since the early days of digital photography there has been a debate about the point 
at which the image quality from digital cameras surpasses the image quality of 
film cameras. It’s not an easy question to answer precisely, because it  depends on 
factors like lens quality, film speed and photographic technique as well as how many 
megapixels your camera  has – but according to Canon a ten megapixel EOS camera 
(such as the EOS 40D) matches the image quality of 35mm film.
	
What is certain is that any recent EOS camera is capable of creating images that 
match or surpass the quality of film. Which brings us to what is probably the most 
fundamental change in photography caused by digital photography – the move from 
processing film and creating prints in a darkroom or laboratory to processing digital 
photo files on a computer and printing with inkjet printers. 
	
This means that there are new skills to learn, something that may be daunting for 
photographers who are not comfortable with computers or who are new to using 
programs like Adobe Photoshop or Canon’s Digital Photo Professional. The learning 
curve is surprisingly steep. Computers do not necessarily make processing photo 
files easy, not at first anyway. Learning to print in a darkroom, especially black 
and white, takes years to achieve a high level of competence. It is the same with 
digital photography.

This last statement is not intended to be discouraging. Learning becomes much 
easier if you’re having fun and getting encouraging results from the start. This 
eBook aims to help you do that by showing you how to process Raw files with 
Canon’s Digital Photo Professional – the free software that comes bundled with 
your EOS camera.

Auckland lantern festival
EOS 5D Mark II, EF 85mm 
f1.8 lens, 1/180 second at 
f2, ISO 400
DPP Brightness 0, white 
balance 2700K, Picture 
Style standard, contrast 
1, highlight 0, shadow 
-1, colour tone -1, colour 
saturation 1, sharpness 3  
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The Raw format
To get the most out of the image quality that your EOS camera is capable of producing, 
you need to use the Raw format. Raw is simply a capture of all the information 
recorded by the sensor at the moment of exposure. It is not actually a photo file, but 
a file containing the unprocessed data captured by the sensor. The Raw file needs to 
be ‘processed’ by Raw conversion software which outputs a photo in either JPEG or 
TIFF format which you can then save, print, upload to the internet or edit further in 
software like Adobe Photoshop CS or Photoshop Elements (you can also print directly 
from DPP without converting the Raw file to a TIFF or JPEG).

Raw and DPP
There are a lot of Raw converters on the market, including Adobe Camera Raw (used  
in Adobe’s Photoshop CS, Photoshop Elements and Lightroom), Apple’s Aperture and 
Phase One’s Capture One Pro 6. These are all excellent Raw conversion programs. But 
they can be quite complex to use, especially for newcomers. 
	
That is where Canon’s Digital Photo Professional (DPP) comes in. It is free – supplied 
on the CD that comes with your camera. Updates are also free, so you benefit 
from advances in the software. Another benefit is that the controls offer the same 
functionality as the image settings within the camera menu. For example, DPP uses 
the same Picture Styles as your camera, something other Raw converters do not do.

DPP does not have the advanced features of the alternative Raw conversion software 
mentioned above. This can be a good thing when you are starting off as there are 
less sliders and options to master. You always have the option of purchasing a more 
advanced Raw conversion program as your expertise improves. 

Blenheim Palace, 
Oxfordshire
EOS 40D, EF 85mm f1.8 
lens, 1/250 second at f9.5, 
ISO 400
DPP Brightness 0.17, white 
balance daylight, Picture 
Style standard, contrast 
5, highlight 5, shadow 
-5, colour tone 0, colour 
saturation 0, sharpness 3  
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Raw vs JPEG
Your EOS camera offers two formats for recording photos, Raw and JPEG. Both 
have their benefits, and are useful in different situations, which is why both 
formats are available. So what are the differences between them?

The main difference is that a JPEG file is an interpretation of the raw data from the 
sensor after it has been processed and saved in a JPEG file by the software inside your 
camera. The Raw conversion is carried out by your camera according to settings such 
as white balance and Picture Style.

The JPEG format is what you would use if you did not want to do any post-processing. 
You can connect the camera directly to a Pictbridge compatible printer and make 
prints right away, bypassing a computer. You could also take the memory card to a 
photo lab. 
	
The JPEG format is also used by professional photographers that need to process a 
large amount of photos at high speed. Wedding photographers may shoot thousands 
of photos at a wedding and save themselves time by using the JPEG format. For a 
photographer who has to edit, process and print thousands of photos taken at a 
wedding, the cost of any time spent at the computer is passed on to the customer. 
	
Photojournalists may also use the JPEG format. Sports photographers in particular take 
high volumes of photos, especially at major sporting events like tennis grand slams 
and World cup or European Cup football. The major newspapers and photo agencies 
are competing with each other to see who can get their photos of major sporting 
events to the market first. Using the JPEG format is a commercial necessity because it 
enables photographers to transmit photos using the internet to their agency offices, 
where they can be rapidly edited and distributed. 

If the JPEG format is so quick and convenient, then why use Raw? Most photographers 
(especially hobbyists) don’t shoot as many photos as wedding photographers, and
	

p. 5
Longhua Temple, Shanghai
EOS 5D Mark II, EF 85mm f1.8 
lens, 1/250 second at f2.8, 
ISO 200
DPP Brightness 0.17, white 
balance 9100K, Picture 
Style nostalgia, contrast 0, 
highlight 0, shadow 0, colour 
tone -4, colour saturation -4, 
sharpness 23
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most photographers don’t have the tight deadlines of sports photographers. The main 
advantage of the Raw format is that you get to do the Raw conversion yourself.
	
The Raw file is like a negative – it is a starting point. A good black and white negative 
can be interpreted by a skilled printer in more than one way. A Raw file is the same. 
You can impose your own interpretation on the photo, using your computer as a 
digital darkroom. You may even make more than one image from a Raw file – such as a 
colour photo and a black and white version. 

White balance
There are some things that you cannot change in Photoshop if you used the JPEG 
format. One of the most important is white balance – you can change the colour 
balance, but it doesn’t give you the same level of flexibility. The ability to change white 
balance to suit the mood you want to create in the photo after you have taken it is one 
of the biggest advantages that Raw has. Choosing the optimum white balance in the 
field is very difficult and time-consuming and often results in a compromise.

Raw power
The main advantage of the Raw format is the amount of information it contains. A 
JPEG file contains eight bits of information in three colour channels (red, blue and 
green). That means each pixel has 256 possible levels of brightness in each channel. 
This equates to a total of 16,777,216 possible colours (referred to as colour values as 
the human eye can’t detect 16 million plus colours – our vision is limited, according 
to the experts, to around 14 million colours). This sounds quite impressive, until you 
realise how much information was captured by the sensor in the first place.
	
Your EOS camera, depending on which model you have, is capable of capturing 
images with a bit depth of either 12 bits or 14 bits. In a 12 bit image, each pixel has a 
brightness range of 4,096 possible values per channel. In a 14 bit image, that leaps to 
16,284 possible values, and a total of over four trillion colour values. All of this extra 
information is contained in the Raw file, ready for you to extract with DPP. If you use

Dongtai Road antiques 
market, Shanghai
EOS 5D Mark II, EF 85mm 
f1.8 lens, 1/180 second at 
f4, ISO 400
DPP Brightness 0.5, white 
balance 5600K, Picture 
Style autumn hues, 
contrast 1, highlight -5, 
shadow -1, colour tone 
0, colour saturation -3, 
sharpness 3  
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the JPEG format when you take photos, the camera converts the information gathered 
by the sensor into an eight bit JPEG file, discarding all the extra information. And once 
it is gone, you cannot get it back.

What does it mean?
So what do these numbers mean to you, in practice? Firstly, it means that the Raw file 
contains a lot of highlight and shadow detail that would be lost if you had used the 
JPEG format. It also means that you have more leeway when altering brightness and 
contrast levels. 

If you are editing an eight bit photo (ie one saved in the JPEG format) that contains a 
large area of continuous tone, such as a blue sky, and you darken the image or increase 
the contrast in a program like Photoshop or DPP, the sky can break up, creating a 
banding effect called posterisation. This is because each pixel is limited to a brightness 
range of 256 values per channel. This is not enough to give a smooth transition from 
dark tones to light tones once you start altering brightness or contrast.

But if you had used the Raw format, each pixel would have  either 4,096 (12 bit) or 
16,284 (14 bit) possible values per channel – enough for a smooth transition across 
areas of continuous tone even once you start altering brightness or contrast. Fourteen 
bit images give a better quality transition than 12 bit images.

What is Raw?
You can think of a Raw file as being like a traditional film negative. The information 
that it contains can be interpreted in a variety of ways in post-processing, in the same 
way that different types of prints can be produced from a single negative.
	
If you save your image as a JPEG, the white balance, colour saturation, contrast and 
sharpness are adjusted in-camera (incidentally, the last three settings are controlled by 
Canon’s Picture Style). The file is also converted from 12 bit or 14 bits to eight bits,  and 
it is compressed so that it takes up less space.
	

Burano, Italy
EOS 40D, EF 17-40mm 
f4L lens @ 40mm, 1/160 
second at f6.3, ISO 200
DPP Brightness -0.33 white 
balance daylight, Picture 
Style landscape, contrast 
2, highlight -4, shadow 
0, colour tone 0, colour 
saturation 0, sharpness 4  
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If the photo is saved in Raw format, the unprocessed image information is 
recorded along with a header file containing all the camera’s settings, including 
contrast, colour saturation, white balance and sharpening. The settings are 
tagged onto the Raw image date and do not actually alter the image – you 
can change and override the settings if you wish. The Raw file needs to be 
processed with software, such as Canon’s Digital Photo Pro, in order to create a 
JPEG or TIFF file that is ready for printing or viewing.
	
The advantages of Raw are that it preserves the maximum amount of original image 
data, giving you full creative control after the exposure and enabling the highest 
possible image quality to be obtained from each file. The software works on a copy 
of the Raw file, so that the original data is untouched. You can keep going back to the 
Raw file and experimenting with different settings to obtain different results. 

The diagram below shows the difference between using the Raw and JPEG formats.

Kaipara Coast Sculpture 
Gardens, New Zealand
EOS 5D Mark II, EF 85mm 
f1.8 lens, 500D close-up 
lens, 1/180 second at f1.8, 
ISO 100
DPP Brightness 0.33, white 
balance 5600K, Picture 
Style standard, contrast 
3, highlight -5, shadow 
-5, colour tone 0, colour 
saturation 0, sharpness 3  
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Raw benefits

Another benefit of shooting in Raw is that Canon will continue to update 
its Digital Photo Professional software in the coming years. Future versions 
will almost definitely include many better tools for Raw conversions than 
are available now, and you will then be able to use them with your older 
Raw files. You can think of DPP as a toolbox with a supply of tools that 
Canon keeps adding to. You never know when a future tool will come in 
useful.

DPP
Why DPP?
If you’re new to image editing you may well be confused by the amount 
of software that is available. In this section I am going to take a look at 
where DPP fits into the range of available software, and exactly what it 
can and cannot do.

Raw conversion vs photo editing software
There are two types of editing software available, and it is important to 
understand the differences between the two. 

The first type is Raw conversion software. This type of program is 
designed to convert a Raw file to the JPEG or TIFF format, and usually 
has minimal editing facilities for JPEG or TIFF files. DPP is Raw conversion 
software, and so are Adobe Lightroom and Apple’s Aperture. 

Image editing software is designed to work with JPEG or TIFF files. The most powerful 
is Adobe Photoshop CS. You can do almost anything to an image with this program. 
Photoshop CS is the industry standard and consequently an expensive program to 
buy. Adobe also make Photoshop Elements 10, which is not as advanced, but still 
powerful. Like Photoshop CS, it is designed for editing JPEG and TIFF files.
	
Both Photoshop CS and Photoshop Elements come with Adobe Camera Raw (ACR for 
short), Adobe’s Raw conversion software (ACR is also used in Adobe Lightroom). This 
means that both of these programs are also Raw converters as well as photo editing 
programs. You could own either one and never feel the need to use DPP or another 
Raw conversion program.

Humahuaca, Argentina
EOS 350D, EF-S 18-55mm lens, 1/80 second at f5, ISO 400
DPP Brightness 0.33, white balance cloudy, Picture Style 
standard, contrast 5, highlight 5, shadow -4, colour tone 0, 
colour saturation 0, sharpness 3  
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Monitor calibration

You may think of monitor calibration as an advanced topic but in reality it 
is easy to do and an absolutely essential part of the photo editing process. 
Uncalibrated monitors have a strong blue colour cast, which means that 
you will not see any of the photos in this eBook (or anyone else’s for that 
matter) how they are intended to be seen. The black-and-white photo 
above, for example, will appear to  have a blue tone on an uncalibrated 
monitor– but in reality the tones are neutral. Many of the differences 
between the comparison photos in this eBook are quite subtle, and are lost 
on an uncalibrated monitor.
	
Our easy to follow guide to calibrating your monitor is on page 77.

The role of DPP
So where does DPP fit into this range of software? It is not an image editing program 
– if you want to edit JPEG or TIFF files then you will need Adobe Photoshop CS, 
Photoshop Elements or another photo editing program made by a different company.

DPP is a powerful Raw converter program. It works in harmony with your EOS camera 
to give you control over the Raw conversion. If all you want to do is convert Raw files to 
the JPEG or TIFF format, and are not interested in the advanced photo editing features 
offered by programs like Photoshop, then DPP could be the only software you will ever 
need.

DPP is powerful but it is not as advanced as the latest versions of Adobe Camera Raw, 
Capture One Pro 6 or Aperture. These Raw conversion programs give you far greater 
control over options like white balance, sharpening, lens aberration correction, and 
black and white conversions.
	
Most other Raw processors also give you localised control. This means that you can 
apply any adjustments you make to just part of the image. In DPP, any adjustments are 
made to the entire image.
	
The role of DPP is probably best seen as an entry level Raw converter. If you are new to 
image editing then it is a great starting point and a very powerful Raw converter in its 
own right, good enough to be used by advanced photographers.
	
However, at some point you may grow out of it and feel the need to upgrade to a more 
sophisticated program. The good thing is that whichever Raw converter program 
you use, the basic principles are still the same. The lessons outlined in this eBook are 
applicable to all Raw conversion programs, not just DPP.
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San Antonio de Lipez, Bolivia
EOS 350D, EF 18-55mm lens, 1.6 seconds at f7.1, ISO 100
DPP Brightness 1.0, white balance 9000K, Picture Style 
landscape, contrast 3, highlight 5, shadow -4, colour 
tone 0, colour saturation 3, sharpness 4  
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Dongtai Road antiques 
market, Shanghai
EOS 5D Mark II, EF 85mm 
f1.8 lens, 500D close-up 
lens, 1/250 second at f8, 
ISO 400
DPP Brightness 1.33, white 
balance 5500K, Picture 
Style standard, contrast 
0, highlight -5, shadow 
-1, colour tone 0, colour 
saturation -2, sharpness 3  

Before we start, let’s look at where DPP fits into a typical workflow. The system outlined 
here is based on the one that I use. Every photographer develops their own workflow, 
but this is a good place to start if you’re new to digital processing. You can then adapt 
it to your own preferences and needs.
	
Start by setting your camera to use the Raw format. After a shoot, copy the photos you 
took to your computer’s hard drive (or an external drive). This is a good stage to make 
a backup of the Raw files to another external hard drive. That way if you suffer from 
hard drive failure or another disaster, you have a backup copy of your photos.
	
Then you can edit your Raw images in DPP. Once your editing is complete, you can 
batch process your chosen files and save them in a new folder in either the JPEG or 
TIFF formats. 
	
If you wish, you can then edit the new files in Photoshop CS or Photoshop Elements. 
You should also consider backing up the new files.

Photo storage
I prefer to save my Raw files on an external hard drive. It is 
easy to back up and means that I am not going to fill up my 
computer’s hard drive. Keeping space free on my computer’s 
hard drive also helps my computer run efficiently. 

Workflow
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Left: Selecting the Raw 
format on an EOS 5D Mark II. 
To set Raw on your camera, 
look for the Quality setting in 
your camera menu.

I store my Raw files on an external 500GB hard drive. There are no other files on 
that hard drive, which makes it very easy to back up the contents onto two more 
hard drives (one is kept away from home in case of theft or fire). I may change the 
system as my photo collection grows, but for now it’s working fine.

File structure
This is also the time to think about the folder structure that you use to store 
your files. It’s important to get organised as early as possible, as it makes it much 
easier to find photos and manage backups. 

I use the following structure to store my photos. I create folders for each year 
(2009, 2010, 2011 and so on). Each folder has 12 more folders inside, one for 
each month. Each monthly folder has a folder for each set of photos taken in that 
month, named according to subject. This makes it easy to find the Raw files that I 
need. I only store Raw files in these folders – the photos that I produce from them 
are stored on a separate external 
hard drive. 
	
I also make sure that after I have 
downloaded Raw files from my 
memory card to an external hard 
drive, that I do not erase them 
from the memory card until the 
Raw files are backed up onto a 
second hard drive. That way, if 
something goes wrong with the 
first hard drive, I have copies.

workflow

Photographer takes 
photos which are 
recorded on the 

camera’s memory 
card

Copy files from 
memory card to 

computer hard drive

Back up files to 
another hard drive

Batch process Raw 
files into a new 

folder, saving them 
in either the JPEG or 

TIFF format

Edit new files in 
Photoshop CS or 

Photoshop Elements

Backup new files to 
another hard drive 

or DVD

edit Raw files in DPP

Above: A typical photographer’s 
workflow. Yours may differ – for 
instance, not all photographers will 
want to edit their photos in Photoshop 
after processing  them in DPP.
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Getting started
When you open DPP it goes to the Main window, where you will see, depending 
on what view options you selected the last time you used DPP, a display 
something like the one on the right.

Toolbar
The Toolbar contains the buttons that you press to access some of DPP’s most 
important functions. It can be turned on and off in the View menu. The  functions 
not labelled in the diagram are explained in detail on the following pages.

Collections
You can add a photo to your collection at any time by going 
to File > Add to collection. The collection gives you quick 
access to any of the photos inside it, regardless of where 
they are stored on your computer.

Folders
A list of the folders on your computer’s hard drive. The photos inside the 
highlighted folder are displayed in the main part of the screen.

Photos
Thumbnail images of the photos inside the selected folder. You can 
change this view by going to the View menu and selecting from 
three thumbnail sizes (large, medium and small) or Thumbnail with 
information, which shows a thumbnail of each photo along with a 
histogram and the shooting information.

Left: The View>Thumbnail with 
Information menu option gives this 
alternative view. A histogram and EXIF 
data are displayed alongside the image 
thumbnails.

The Info button 
brings up a window 
containing the EXIF 
data of the selected 
image.

Use the Select all 
and Clear all buttons 
to select or unselect 
all the images in a 
folder.

The rotate buttons 
turn the thumbnails 
90 degrees clockwise 
or anti-clockswise.

You can vlick and 
drag thumbnails 
with the mouse to 
rearrange them
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Quick Check
Editing your photos is an important part of the photographer’s workflow. DPP has 
a tool to help you select the best photos in a folder. It is called the Quick check 
tool and lets you look at each photo at full size on your computer screen, and 
assign Check marks and Ratings to assist you in categorising your images.
	
Start the Quick check tool by selecting the photos you want to look at closely 
(use the Select all button to select every image in the folder) by going to Tools 
> Start Quick check tool in the menu. Use the Previous and Next buttons to 
scroll through the photos. You can click on the 50% view or  Full screen buttons 
to get a 50 percent or 100 percent view. This allows you to zoom right into your 
photo to check for fine detail, focusing accuracy and so on. You can tick the 
AF point box to see the active autofocus (AF) point when you took the photo, 
and the Image Information button to bring up a window with the shooting 
information. You can also use the Rotate left and Rotate right buttons to rotate 
the image, if needed.

Check marks and Rating
You can use the Check mark and Rating functions in any way you like to help 
you organise your photos. For instance, you could assign a five star rating to the 
best photos in the folder, and use the Reject button to mark any photos you 
don’t intend to process.  Go to View > Sort at any time in the Main window to 
rearrange the thumbnails according to the assigned Check mark or Rating (as well 
as name, shooting date or Raw priority – in name order but with Raw files first, 
then JPEGs then TIFFs). You can also access Check marks and Ratings from the 
Label menu or the icons below the Toolbar in the Main window.

The Rating or Check 
mark that you assign to 
an image is displayed in 
the Edit image window 
next to the thumbnail. 
Rejected images are 
also marked.
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Edit window

In the Main window, click on an image to select it and click the Edit 
image window button. The Edit image window is where you edit the 
Raw file (the editing process is covered in the next section of the eBook). 
Editing is carried out using the tools in the Raw, RGB and NR/Lens/ALO 
tabs in the Tool palette on the right hand side of the screen. If you cannot 
see them, click the Tool button in the toolbar to bring them up.

In the Main window, each photo is appended with information about 
the image. Some of it is fairly obvious – the the word Raw is used in the 
bottom left to indicate the file type.  The lens symbol in the top right 
indicates that there are lens corrections applied to the image. The word 
Raw at the bottom right indicates that the image has been edited under the Raw tab – 
and the initials RGB are greyed out to show no changes were made under the RGB tab. 
A brightness adjustment is indicated by the +0.1 on the left, and the white balance 
setting by the daylight icon. The asterix indicates that there are unsaved editing 
changes – these are saved when you exit DPP (or by going to File > Save).

Multiple images
You can edit multiple images by selecting more than one photo in the 
Main window then clicking the Edit image window button. Click the 
Thumbnails button to see thumbnails of the selected images in a pane 
on the left-hand side of the Edit image window.

TIP: If your images take a 
long time to render in the 
Edit image window, go to 
the  General settings tab in 
Preferences and untick the 
View images at high speed 
(moire reduction off) box. 
You can speed up DPP even 
further by selecting the High 
Speed setting – although you 
won’t be able to use the noise 
reduction palette if you do.
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Most Raw editing is carried out using 
the tools under the Raw, RGB and NR/
Lens/ALO tabs in the Tool palette. 
Most of the time you will use the Raw 
and NR/Lens/ALO tabs. The RGB tab is 
meant for editing TIFF and JPEG files, 
but does have a couple of features that 
may come in useful for editing Raw files 
too.

On these two pages I’ve highlighted 
the most important tools in the Tools 
palette, with a brief explanation of 
what they do and a page reference 
where the tool is discussed in detail.

1. Brightness
Use the brightness slider to adjust the brightness of the image or to compensate for 
over or underexposure (p. 24)

2. White balance adjustment
Lets you take control of the colour balance of your image by setting the colour 
temperature. (p. 26)

3. Picture Style
Alters the look of your image. You can use the same Picture Styles that your camera 
has, download more from the Canon website or create your own. (p. 20)

4. Histogram
Helps you visualise the tonal distribution and dynamic range of your image. (p. 20)

5. Contrast, exposure and colour sliders
This is where you make fine adjustments to the contrast, highlight or shadow detail, 
colour and sharpness.(p. 33)

Raw tab

The tool palette
1

2	

3

4

5

1

2	

3
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1. Auto Lighting Optimizer
The Auto Lighting Optimizer helps 
compensate for backlit subjects. If the 
camera used to take the photo doesn’t 
support the ALO option, this option will 
be greyed out in DPP. (p. 52)

2. Noise reduction
Remove noise from your photos, or at 
least reduce it. (p. 49)

3. Lens aberration correction
Correct vignetting, chromatic aberration 
and other lens distortion. Every lens 
suffers from distortion or aberration of 
some sort (although it is mimimal on 
high quality lenses). DPP lets you correct 
them. (p. 41)

NR/Lens/ALO tab

1. Curves
Tone black and white photos (p. 62)

2. Contrast, exposure & 
colour sliders
These are for altering the brightness, 
contrast and colour of TIFF and JPEG files 
– although you can also use them with 
Raw files. 

RGB tab

1

2	

3

1

2	
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To this...

If you are using the Raw format it is quite possible that 
your photos will look somewhat disappointing when 
you view them as shot. But don’t worry, you haven’t 
done anything wrong – it’s just because you haven’t 
done any processing work yet. It takes a little work to 
bring the best out of your Raw files, but once you’ve 
mastered the process you will see that it doesn’t take 
much effort to dramatically improve your images. 
Take a look at the example on the right to see the 
potential difference you can make with DPP. 
	
We’ve already taken a look at workflow – an important 
concept in digital photography and one that also 
applies within DPP. One of the biggest advantages 
of  processing Raw files with DPP is that the changes 
you make are non-destructive. This means that the 
original data captured in the Raw file is unchanged, 
even after you save your edits. It also means that 
you can undo any changes you have made, or even 
reprocess the image again in the future. 

What can be confusing is deciding on the appropriate 
order for using DPP’s sliders and controls. The following pages outline the order that 
I use them in. It’s a good place to start until you become comfortable enough with 
DPP’s functions to decide for yourself the best order to use.

From this...

DPP workflow
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Starting image
This is the output from original Raw 
file, without any alterations.

1. Picture Style
The Picture Style you choose affects the 
contrast, colour saturation, colour tone 
and sharpness of the photo. This photo 
of Venice was taken using the standard 
Picture Style and I changed it to the 
landscape Picture Style. The landscape 
Picture Style emphasises  green and 
blue tones and lifts contrast to make 
distant objects clearer. Picture Styles are 
covered in more detail on page 22.

2. Brightness adjustment
The photo looks a little dull because 
it is underexposed. In a perfect world 
the photographer would have exposed 
more accurately in the first place. But I 
did not, so I can easily adjust that with 
the Brightness adjustment slider (more 
details on page 26). 
	
It is worth thinking about the effect you 
want to achieve with your photos here. 
Are you looking for a bright airy feel, or a 
darker, more sombre one, or somewhere 
in-between? This photo was taken at 
twilight and I wanted it to reflect that. So 
I brightened it, but not by too much.

3. White balance
This is where you can make a real 
difference to the photo by setting a 
white balance that reflects the mood 
you were trying to capture. Here I set the 
white balance to give the photo a warm 
colour cast that enhances the colours 
of the sunset. White balance is covered 
fully on page 28.
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4. Tweaking the image
There are six sliders underneath the histogram that 
control contrast, highlight detail, shadow detail, 
colour tone, colour saturation and sharpness. They 
are initially set to match the Picture Style that you 
have chosen, and you can use them to fine tune 
the appearance of the photo.
	
Here I adjusted the highlight slider to brighten 
the sky, the shadows slider to darken the shadows 
underneath the gondolas, and the colour 
saturation slider to deepen the warm colours. This 
is covered in detail on page 35.

5. NR/Lens/ALO tab
Now we move to the NR/Lens/ALO tab. The photo 
was taken with a Canon EF 17-40mm f4 L lens. The combination of low contrast 
lighting and an L series lens means that there is hardly any chromatic aberration 
in the photo. However, there is still a little around the edges of the wooden 
poles on the right and left and sides of the image. I used the Lens aberration 
correction function (activated by clicking the Tune button) to correct the 
chromatic aberrations and to eliminate the vignetting (darkening at the edges of 
the frame) that is a natural characteristic of wide angle lenses.
	
Then I used the Noise reduction function to reduce the chrominance noise in 
the photo. The photo was taken at ISO 1600 so the noise levels were a little high, 
but DPP eliminated most of it. The NR/Lens/ALO tab is covered on page 43.

6. Trimming tool
Finally I used the Trimming tool to crop the posts on the right of the photo. The 
Trimming tool has several uses and is covered on page 55.

Before.... After....
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Picture Styles
The Picture Style options in DPP match the Picture Styles on your EOS camera (see 
page 25 for a list of EOS cameras that support Picture Styles). If you have an older EOS 
camera that doesn’t support Picture Styles, you can apply Picture Styles in DPP as long 
as you use the Raw format. 
	
What is a Picture Style? In the days of film, you could buy different types of film to suit 
the subject you were shooting. So you might buy Fuji Velvia, a slide film with high 
contrast and saturated colours, for landscape photography, or Kodak Portra, a colour 
negative film designed to give warm, flattering skin tones, for portraits.
	
Now, instead of buying film, you set a Picture Style that corresponds to the subject 
that you are shooting. The landscape Picture Style, for example, boosts contrast and 
sharpness and emphasises blue and green tones. The portrait Picture Style gives soft, 
natural looking skin tones making it ideal for shooting portraits. There are is also a 
monochrome Picture Style for shooting in black and white.
	
If you select the JPEG format when you take a photo you are stuck with the Picture 
Style that you set on the camera. You can make some changes afterwards in a program 
like Photoshop but it is not as convenient as the Raw format. By using Raw you can 
change the Picture Style in DPP. This is useful because you can decide which Picture 
Style is appropriate when you are editing your images, rather than having to guess 
which one would be best before you take the photo.
	
For instance, you may set landscape Picture Style because you are taking landscape 
photos – a logical choice. But for some landscapes the landscape Picture Style can be a 
little strong, and the standard Picture Style is more suitable. With Raw you can change 
the Picture Style in DPP, with JPEG you can’t.

The same photo, 
but one version is 
processed with the 
standard Picture 
Style (right) and 
the other with the 
landscape Picture 
Style (above). The 
landscape Picture Style increases colour saturation in the blue 
tones, bringing the best out of the deep blue mediterranean sky 
and the blue painted house. The difference is subtle – it is clearest 
in the top left hand corner of the photo.

Landscape Picture Style

Standard Picture Style
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Picture Style Guide
There are six Picture Styles in DPP (matching the six built-in to EOS cameras). Of those, 
these are the four Picture Styles that you will use the most:

Standard
The standard Picture Style is designed for general use. It increases colour saturation 
and sharpness slightly to create a pleasing result.

Portrait
Skin tones can be difficult to manage as the slightest colour cast is obvious even to 
the untrained eye. The portrait Picture Style overcomes this by adding brightness and 
adjusting the colour to give a light pink skin tone.

Landscape
Increases saturation in green and blue colours. The image is sharpened a little more to 
bring out more detail in distant objects like trees, buildings and mountains. 

Monochrome
Use this Picture Style to convert your photo to black and white (black and white 
conversions are covered in more detail on page 62).

Portrait Picture Styles
The top two photos on the right show the difference between the 
standard and portrait Picture Styles.  The portrait Picture Style is 
designed to give bright, accurate skin tones for flattering portraits. 
There are a further two portrait Picture Styles available from the 
Canon Japan website (see page 25) – portrait studio and portrait 
snapshot, illustrated by the bottom two photos. The difference 
between these two Picture Styles is very subtle – you will have to 
look hard to see it.

Portrait studio Picture Style

Portrait snapshot Picture Style

Portrait Picture Style

Standard Picture Style
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The next two Picture Styles are unlikely to be used much. They are designed to be used 
in-camera to produce JPEG files that will be worked on in Photoshop:

Faithful
The Faithful Picture Style replicates the way the human eye sees colours, resulting in 
accurate, true-to-life colours in all lighting conditions. It accurately captures both vivid 
and soft colour tones and is useful for product photography and copying photos and 
documents where colour accuracy is important.

Neutral
The Neutral Picture Style decreases contrast and colour saturation in order to retain 
highlight detail. If you are photographing a vividly coloured object like a red car, the 
standard Picture Style can oversaturate the colours, resulting in a loss of subtle tonal 
variation. The neutral Picture Style captures more details in vivid colours and bright 
highlights.

Nostalgia Picture Style
If you like photographing old things then 
I recommend that you download the 
nostalgia Picture Style from the Canon 
Japan website (see next page). It creates 
a unique look that suits the colours and 
textures of old things. You can vary the 
look by playing around with the colour 
saturation and contrast sliders, and 
warming up the image using the white 
balance setting (white balance is explained 
further on page 28). 

Nostalgia Picture Style

Standard Picture Style
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You can download seven more Picture Styles from the Canon Japan website at www.
canon.co.jp/imaging/picturestyle/index.html and use them with DPP – or upload 
them to any EOS camera that supports user defined Picture Styles:

Twilight
An artistic style that enhances the soft purple hues of an image taken shortly after 
sunrise or before sunset.

Nostalgia
The Nostalgia Picture Style imitates the appearance of an old photograph by setting 
an umber colour tone and reducing green and blue colour saturation.

Clear
The clear Picture Style increases contrast to make the subject clearer. Use it in hazy 
conditions or for shooting a subject behind glass.

Emerald
This Picture Style enhances green tones – use it for bringing out the best in subjects 
like green trees and tropical seas.

Autumn Hues 
Enhances the red and yellow shades typical of an autumn scene.

Studio Portrait
The studio portrait Picture Style has less sharpness and contrast than the portrait 
Picture Style. It is suitable for wedding or fashion shoots where it is important to retain 
the texture and detail of fabric or jewellery. 

Snapshot Portrait
The snapshot portrait Picture Style has higher contrast and gives skin a translucent 
appearance that suits casual portraits and snapshots.

Picture Style directory

The following cameras have Picture Styles built-in:

EOS 400D, 450D, 500D, 550D, 600D, 1000D, 1100D, 30D, 40D, 50D, 60D, 7D, 
5D, 5D Mark II, 1D Mark II N, 1D Mark III, 1D Mark IV, 1Ds Mark III, 1D X

The following Picture Styles 
are built-in to EOS cameras:

•	 Standard
•	 Portrait
•	 Landscape
•	Neutral
•	 Faithful
•	Monochrome
•	User defined (3 sets)

The following Picture Styles are 
currently available for download 
from www.canon.co.jp/imaging/
picturestyle/index.html

•	 Studio Portrait
•	 Snapshot Portrait
•	 Nostalgia
•	 Twilight
•	 Autumn Hues
•	 Clear
•	 EmeraldTo use a Picture Style that 

you downloaded from the 
Canon Japan website, click 
the browse button next to 
the Picture Style drop down 
menu, navigate to the folder 
where you saved it and 
select it. You can then adjust 
the contrast, highlights and 
shadows, colour tone, colour 
saturation and sharpness 
just like you can with the 
built-in Picture Styles.

http://www.canon.co.jp/imaging/picturestyle/index.html
http://www.canon.co.jp/imaging/picturestyle/index.html
http://www.canon.co.jp/imaging/picturestyle/index.html
http://www.canon.co.jp/imaging/picturestyle/index.html
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Brightness
The Brightness adjustment slider lets you adjust the brightness of the image 
the equivalent of up to two stops brighter or darker. While this can help rescue 
images where you didn’t get the exposure right in the first place, you should 
really think of the Brightness adjustment slider as a tool to help you fine tune 
the brightness of the image. There are very few images where the brightness is 
spot on when you first look at them in DPP – most photos benefit from at least in 
small adjustment in one direction or the other. 

The Brightness adjustment slider is marked in stops, and differs from something 
like the Levels tool in Photoshop because you are working with a Raw file rather 
than an eight bit JPEG file. The Raw file contains all the information captured by 
the sensor at the point of exposure, and DPP uses this to maximise detail in the 
highlights and shadows, and to minimise noise if you are 
brightening an underexposed image. DPP can’t put back 
in highlight or shadow detail that wasn’t captured by the 
sensor in the first place, but it will give you a better result 
than you would get if you had used the JPEG format.

The Brightness adjustment slider is a key tool for 
processing your photos – you should use it before you 
touch the Contrast, Highlight and Shadow sliders (see 
page 35) to set the overall brightness of the image. You 
can always tweak the setting afterwards if you need to as 
you adjust the other sliders.

The Brightness adjustment slider alwys starts off at zero and you can 
set it anywhere between -2.0 and +2.0 stops (illustrated above – you 
won’t need to go anywhere near those two extremes if your exposure 
was accurate). 

If you drag the slider with the mouse it moves in increments of 0.17 
stops at a time. If you need a finer adjustment than this, you can 
achieve it by entering the figure in the field to the right of the slider. 
You can also return to the original zeroed setting at any time by 
clicking the button with the curved arrow icon.

Another potential use of the Brightness adjustment slider is to create 
three different images to use 
as the base for creating a High 
Dynamic Range (HDR) image. 
You do this by creating three 
different versions of the same 
photo – one with Brightness 
adjustment set to -2.0, another 
with it set to zero, and the 
third with it set to +2.0. You 
can then combine the three 
images using a program like 
Photoshop CS or Photomatix.
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The histogram displayed in DPP shows the dynamic range of the tones recorded by 
the camera’s sensor. It can be confusing at first because it doesn’t match the histogram 
on the back of your camera (the histogram under the RGB tab is closer to that). 

The zero setting on the histogram is equivalent to a mid-tone. Bright tones have a 
positive value, and darker tones a negative value. The histogram extends to nearly 
+4.0 stops on the right and -9.0 steps on the left. This is a vast range and in practise the 
graph won’t fill the whole scale. 

The image’s curve is also displayed, superimposed above the histogram. The curve 
changes when you make adjustments to the Contrast, Highlight or Shadow sliders. 
It doesn’t change when you adjust 
brightness – instead you’ll see the 
histogram shift to the right or to the left.

You can reduce the dynamic range of 
the image by moving the lines that mark 
the left and rightmost limits. You need 
to be careful of clipping in the highlights 
and shadows.  I don’t se them often as 
it’s easier to make changes using the 
Contrast, Highlight and Shadow sliders.

You can also move the lines at the top 
and bottom of the histogram up and 
down to change what Canon refer to as the output values of the image – but you will 
never need to do this.

HistogramCurve

The left and right sides 
of the histogram – you 
can reduce the image’s 
dynamic range by moving 
these inwards.

The dynamic range of the 
image, indicated in stops.

The dynamic range of an image is dependent upon 
the brightness range of the light reflected from the 
subject of the photo.  Here are two histograms from 
two different images. The tones within the graph 
in the histogram on the left cover a much wider 
range than the tones in the histogram on the right.  
The image that this histogram was generated from 
(shown on the left) has a lot more contrast than the 
image that generated the other histogram (you can 
see the image on page 26). The Contrast, Highlight 
and Shadow sliders let you increase the contrast 
within flat images.

The histogram



p. 28
28

If you use the JPEG format, you have to get the white balance right at the time you 
take the photo. While you can adjust colour balance in Photoshop, you cannot actually 
adjust the white balance itself.  The difference is important because the ability to 
adjust white balance gives you more freedom in interpreting the image. You can also 
adjust white balance without degrading the image in any way because of the non-
destructive nature of Raw processing.

White balance is related to colour temperature. The 
colour of light changes according to the weather 
conditions and time of day. On a cloudy day, or at dusk 
after the sun has set, the light is blue. At sunrise or 
sunset it is orange. It is more likely to have a neutral 
colour in the middle of the day. Artificial lights create 
their own colour casts.
	
The aim of the Auto white balance feature on your 
camera is to produce a photo with a neutral colour 
cast. The camera will attempt to compensate for any 
colour cast created by the light.
	
Is this a good thing? It certainly can be – but only if 
you want to create neutral photos. I don’t use it – I 
prefer to adjust the white balance myself. I rarely go for a neutral colour balance, 
instead I prefer to go for either a cool or a warm colour balance, depending on the 
mood that I’m trying to create. The only question is how cool, or how warm, the image 
should be.  White balance is a key creative decision and setting white balance is part of 
the process of deciding how to interpret a Raw file when you process it.

White balance is one of the best tools 
that you have for creating mood in 
colour photography. Using the Raw 
format gives you the opportunity to 
fine tune white balance in DPP in a way 
that would be impossible with a JPEG 
file. Furthermore, you can also interpret 
the same Raw file two different ways, 
as in this example. It is the same photo, 
and the only difference is in the white 
balance. The result is one image with 
cold blue tones that captures the 
atmosphere of the scene as night falls, 
and another that replicates the warm 
tones of sunset.

White balance 10,000K plus tune button
(Colour tone: 348, Colour saturation: 181)

White balance 4,800K

White balance
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White balance in action
The white balance function is located under the Raw tab in DPP. Clicking on the drop 
down menu brings up a list of ten settings. For simplicity they can be divided into 
three groups. The first group is general purpose settings that you will use most often:

Shot settings
Matches the white balance setting that you set on the camera when the photo was 
taken.

Auto
DPP calculates the white balance it thinks should be applied to the photo. This is a 
good option to select to see what happens, but do not be surprised if it does not get it 
right. Furthermore, the Auto setting is designed to calculate a neutral white balance – 
you may wish to make the image warmer or cooler.

Daylight
Sets the white balance to 5200K. This is designed to give neutral colours at noon on 
a sunny day. This is like using a daylight balanced film. Photos taken by the light of 
the setting sun or a tungsten bulb have a warm colour cast at this setting, and photos 
taken in the shade or on a cloudy day have a cool colour cast.

Cloudy
Use this setting if you took the photo on a cloudy day. It gives a warmer colour cast 
than the daylight setting.

Shade
This setting gives a stronger warm colour cast than cloudy. It is designed for taking 
photos in the shade on a sunny day. Photos taken in these lighting conditions have a 
strong blue cast.

What is colour temperature?
Colour temperature is measured on the Kelvin (K) scale. It is the 
standard against which the light emitted by different sources is 
measured.
	
The colour temperature scale is determined by the colours that a 
standard black body (a physics term meaning a non-reflective perfectly 
black piece of metal) glows when it is heated to a certain temperature. 
Low temperatures glow orange or red and high temperatures glow 
blue. 
	
The aim of the white balance function in DPP (and on your camera) 
is to compensate for the colour 
temperature of the light 
illuminating the subject. For 
example, if your subject is lit by 
tungsten light, which has a strong 
orange cast, you need to make the 
image more blue to correct the 
orange cast (this is the equivalent 
of using a blue tungsten filter with 
daylight balanced film).

The table on the page 33 shows 
the Kelvin scale in action, the point 
at which different light sources 
come on it, and the corresponding 
settings in DPP (shown in the 
white balance drop down menu on 
the right).
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These three settings are for specific lighting conditions:

Tungsten
Light cast by tungsten light bulbs has a very warm colour cast. The tungsten setting 
is designed to give a neutral colour cast under this light. It is really intended for 
photographers who are using tungsten studio lights as a continuous light source but 
require neutral colours. 
	
If you were taking photos by the light of a household bulb, you may want to retain the 
warm colours for creative reasons, in which case you would set the white balance to 
daylight.

White fluorescent light
Use this setting for taking photos lit by fluorescent lights. It is best to avoid shooting 
under fluorescent light whenever you can, especially if your light sources are mixed 
(ie fluorescent and daylight) as you cannot set a white balance that suits both types of 
lighting.

Flash
Intended for use in-camera. It tells the camera to communicate with the Speedlite 
flash to measure the colour temperature of the light output by the flash, which can 
vary slightly from unit to unit. Not much use in DPP.

The last two settings are more precise tools to help you arrive at the correct white 
balance setting:

Colour temperature
A slider appears when you click this option that lets you adjust the colour temperature 
manually on a scale of 2500K to 10000K. The default is 5200K, moving the slider left 
cools the photo down, moving it right warms it up.

Cloudy

Auto
Which of these two 
photos do you prefer? 
Auto white balance 
gives you the result on 
the right. Change it to 
cloudy and you get the 
warm toned version 
above. The warm white 
balance enhances the 
knight’s red regalia and 
the umber hues in the 
background.
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Click white balance
A tool to help you obtain a neutral white balance. All you do is click on the 
eyedropper icon, then on a pure white or mid-grey tone in the photo. DPP then 
calculates the white balance required to render the white or grey tone you clicked 
on a neutral tone. 

Registering white balance settings
DPP has three personal white balance settings. To use them, click the Register 
button and select a custom setting in the Register personal white balance 
window (Custom1, Custom2 or Custom3) and click OK. This stores the current white 
balance settings so that you can recall them to use with other images.  

While I like to play around with making photos warmer or cooler for 
creative effect, there are times when a colour cast just looks unnatural. 
This can happen when there is a dominant white tone in the photo, like 
the images of a white flower on the right. To me, the photo created from 
the daylight white balance setting has  a  warm cast and looks unnatural. 
It’s not really visible in the green tones but it is fairly obvious in the white 
part of the flower. The photo on the left has neutral whites and looks 
much better. I arrived at this white balance setting quite easily by using 
click white balance. All I had to do was click with the eyedropper on a 
white part of the image, and DPP calculated the  white balance setting 
required to remove the colour cast. This also works with grey tones. 

A practical application of the click white balance function is that, when 
correct colour is critical, you can take a test photo that includes an 18 
percent grey card. Use click white balance and the eyedropper to click on 
the grey card and set the correct colour temperature. You can then save 
it in one of the personal white balance settings and apply it to photos 
taken without a grey card. As long as the lighting conditions are the 
same, it will work.

Click white balance

Daylight white balance
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The Tune button
DPP has a further white balance tool to help you alter the white balance of 
your photo with precision. Once you have set your white balance using any of 
the settings listed above, click on the Tune button. The White balance fine 
adjustment window appears. Drag the small square in the centre of the colour 
wheel towards any of the colours to fine tune the white balance (or change it 
quite dramatically if you want). The further you move towards the outer edge 
of the circle, the stronger the colour saturation. The tone and saturation are also 
given in numerical values so that you can make a note of the settings you used.

Why would you want to use the White balance fine adjustment 
window? The colour temperature slider works by making your image 
more orange, or more blue (warmer or cooler). But there are times 
when you may need to shift the colour balance in another direction. 
A good example is if you took a photo under fluorescent light, which 
may have a green colour cast. To counter the green cast you need to 
increase the amount of magenta in the image, and you do this with 
the Tune button (other Raw converters have a green/magenta slider 
along with the blue/orange slider in the white balance settings for this 
purpose).

Take a look at the photo on the bottom right. I moved the colour 
temperature slider to 10,000K – the highest it 
will go. But even so, the colours in the image 
are not that warm. So I used the Tune button, 
and added red to the image to create the photo 
at top right. The White balance fine adjustment 
window permitted me to push the colours 
beyond the settings provided by the colour 
temperature slider.

10,000K

10,000K plus tune button
(Colour tone: 22, Colour saturation: 184)
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1000K 2000K 3000K 4000K 5000K 6000K 7000K 8000K 9000K 10000K

candlelight
(1000K-2000K)

household 
tungsten bulb

(2500K-3500K)

sunrise or sunset 
on a clear day
(3000K-4000K)

flourescent 
lamps

(4000K-5000K)

electronic 
studio flash
(5000K-5500K)

daylight on a 
sunny day

(5000K-6500K)

cloudy sky
(6500K-8000K)

shade or very 
cloudy sky

(9000K-10000K)

auto white 
balance (AWB)
(approximately 
3000K-7000K)

colour temperature
(lets you set colour 

temperature manually 
anywhere on a scale from  

2500K-10000K)

daylight
(approximately 

5200K)

shade
(approximately 

7000K)

flash and 
cloudy

(approximately 
6000K)

tungsten
(approximately 
3200K)

flourescent
(approximately 

4000K)

white balance settings in DPP

colour temperature of light sources
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Your sitters will thank you if you can 
make their portraits flattering. One 
way to do this is to use the cloudy or 
shade white balance settings. Either 
will probably work out fine – shade is 
the warmer of the two. Set the white 
balance to auto though and it is a 
different story. The photo may be more 
neutral, but not as flattering.

The Picture Style and white balance 
settings should work together in 
harmony. Once you have chosen your 
Picture Style, you can adjust the white 
balance to bring the best out of your 
photo. Do not be afraid to go back 
and change the Picture Style though. 
Experimentation – and playing – are the 
keys to learning.
	
With this photo, I had the choice between 
three Picture Styles – portrait, portrait 
studio and portrait snapshop, and three 
white balance settings – auto, cloudy and 
shade. 
	
The differences between the three 
portrait Picture Styles are quite subtle; 
you may have to look closely to see them. 
The choice of which Picture Style and 
white balance to use should be led by 
the effect you are trying to achieve. In 
this case I wanted a warm toned portrait 
and selected the appropriate settings 
to achieve that. I set the Picture Style to 
portrait and the white balance to shade 
because it gave the warmest portrait. 

The other settings are not necessarily 
wrong – it is all down to personal taste 
and how you want the photo to look.

Shade / Portrait studio Cloudy / Portrait

Auto / Portrait

Shade / Portrait

Shade / Portrait snapshot
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Setting highlight to -5 
brings out more detail in 
the white petal without 
affecting the rest of the 
photo.

The brightness, contrast, 
highlight and shadow 
are all set to zero.

Setting highlight to +5 
brightens the white petal 
without affecting the 
background. Compare 
it with the previous two 
images to see how much 
detail has been lost.

The six sliders underneath the histogram are for making adjustments to the Raw 
image. You should only use them after you have already set the brightness adjustment, 
Picture Style and white balance. Any changes you make with these sliders are linked to 
the selected Picture Style. For instance, if you are using the standard Picture Style and 
increase the contrast to +2, the contrast will revert back to the default (0) if you switch 
to another Picture Style. 

Contrast
This slider does exactly what the name suggests – it alters the contrast of the image. 
You can lower the contrast by moving the slider left or increase it by moving it right. 
Try playing around with the slider to see the effect. You’ll see that highlights get 
brighter (and may burn out) and that the shadows get darker (you may lose detail 
here too) when you increase contrast, and the opposite happens when you decrease 
it. The image curve in the histogram also changes. You can use the highlight and 
shadow alerts to warn you when you are losing highlight or shadow detail – their use 
is explained on page 37. 

Highlight	
Move the highlight slider right to brighten the highlights and left to darken them. 
Most of the time you will want to set the highlights so that they are bright but not 
clipped (the highlight alert will help you find this level). 

Another use of the highlight slider is for retrieving detail from clipped highlights. If 
you use the highlight alert feature on your camera you will be used to seeing flashing 
black patches on the LCD screen when you playback your images that indicate clipped 
highlights. However, the image on the LCD screen is generated from a JPEG file created 
when the photo was taken. If you’re using the Raw format, a Raw file contains more 

brightness 0, contrast 0, 
highlight 0, shadow 0

brightness 0, contrast 0, 
highlight -5, shadow 0

brightness 0, contrast 0, 
highlight +5, shadow 0

Contrast sliders
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information than a JPEG file thanks to the extra bit depth (12 or 14 bits compared to 
eight bits). This means that there is at least a little detail in clipped highlights – and you 
can bring this out in DPP. 

Part of the work is done with the brightness adjustment and contrast sliders. Moving 
the brightness adjustment slider left darkens the image and brings out highlight detail 
at the same time.  Lowering the contrast also helps bring out highlight detail. The 
important thing to remember about the brightness adjustment and contrast sliders is 
that they affect the entire image – you can’t darken the highlights without darkening 
the rest of the image. 

The highlights slider on the other hand just affects the highlights – you can move it left 
to darken the highlights and bring back apparently lost detail without darkening the 
rest of the image.

Shadow	
The shadow slider works the same way as the highlight slider except that it affects the 
shadow areas only, not mid-tones or highlights. Use it to darken or lighten the darkest 
areas of the photo.

Working together
While I recommend that you set the brightness adjustment before you use the 
contrast, highlight and shadow sliders, once you start altering contrast, highlight and 
shadow settings you can also alter brightness adjustment if you need too. The four 
sliders work together. Just remember that brightness adjustments sets the overall 
exposure level, the contrast slider sets the overall contrast, the highlight slider affects 
highlights only and the shadows slider only affects shadow detail. The examples on the 
right of these two pages show how it works.

Here I set highlight to +5 
and then darkened the 
entire image using the 
brightness adjustment 
slider. This brought back 
the detail in the petal 
but darkened the rest of 
the image as well.

brightness -0.83, contrast 0, 
highlight +5, shadow 0

For this photo I kept the 
brightness adjustment 
and highlight at zero, 
and darkened the 
background by setting 
shadow to -5. 

brightness 0, contrast 0, 
highlight 0, shadow -5

In this extreme example 
I set contrast to +4, 
then highlight to -5 to 
bring back the highlight 
detail in the petal, and 
shadow to -5 to darken 
the background. The 
contrast of the image is 
too high for it to print 
or reproduce well, but it 
shows what can be done.brightness 0, contrast +4, 

highlight -5, shadow -5
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The highlight and shadow alerts are provided by DPP to let you know if there is 
clipping in the highlight or shadow areas of your image. They are useful at all stages of 
the editing process, but especially so when you are adjusting the brightness or using 
the contrast, highlight or shadow sliders.
	
What is clipping? A clipped highlight is part of the photo that has reached its 
maximum brightness level. You cannot brighten it any further, and it also has no 
textural detail. It may be caused by overexposure when you took the photo, but it is 
also caused by brightening the photo or increasing contrast in DPP.
	
A clipped shadow is part of the photo that is approaching the maximum dark level. 
You cannot darken it any further and it has lost all detail.
	
Many photos have at least some clipped shadows, and some may also have clipped 
highlights. Generally speaking, clipped shadows look natural (as long as there are 
not too many) but it’s best to avoid clipped highlights, as they look unnatural. This is 
particularly true if the highlight detail is present in the Raw file – the reason that DPP 
has a highlight slider is to give you a tool to retain highlight detail even if you increase 
the brightness or contrast. Sometimes, clipped highlights are unavoidable, usually due 
to overexposure at the point the photo was taken.  This could happen when taking 
backlit photos, for example, as the contrast range of the scene exceeds what the 
camera’s sensor can record.

Activate the alerts by going to View > Highlight Alert or View > Shadow Alert. 
Clipped highlights show in red and clipped shadows in blue. You can turn the alerts on 
or off as needed.

Clipped highlights

Clipped shadows

The alerts
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The colour tone slider is intended to be used to correct colour casts on skin. It works 
very simply – just move the slider to the right to make skin tones more yellow, or to 
the left to make them redder. The scale runs from -4 (redder) to +4 (more yellow). The 
differences between each step are subtle.
		
Our eyes are very sensitive to skin that is off-colour – it just looks wrong even if we 
are not sure why. The colour tone slider allows you to change the overall colour tone 
of the photo. It should be used after you have set the white balance and Picture 
Style. It should not be used because you have not set the white balance or Picture 
Style correctly – it is a tool you that you can use to fine tune the colour tone, not to 
get it right in the first place. If the white balance and Picture Style settings have been 
set correctly, most of the time you will not have to touch the colour tone slider. The 
examples on the right show the effect – I’ve used the extreme settings to show the 
effect, in reality these are too strong and you are more likely to use the intermediate 
settings.
		
You can also use the colour tone slider with subjects other than portraits. Again, you 
should use it to fine-tune your photos after you have already set the white balance and 
Picture Style. 

colour tone 0

colour tone -4 (red)

colour tone +4 (yellow)

Colour tone
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colour tone +4 (yellow)

colour tone -4 (red)

The use of the Color tone slider is not 
limited to portraits. In this example 
increasing moving the slider to the right to 
increase the yellow tones has enhanced the 
green colours of the seed head. Which do 
you prefer? 

colour tone 0

39
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You can alter the intensity of the colour in your photos with the colour saturation 
slider. You should only touch this slider after adjusting the Picture Style and white 
balance – if your photos appear to be lacking 
colour saturation the first thing to check is 
the Picture Style. The standard, landscape and 
portrait Picture Styles have the most intense 
saturation, and the neutral and faithful Picture 
Styles the least. The colour saturation slider is 
for fine tuning the colour saturation set by the 
Picture Style settings. There is a scale of -4 to 
+4, where zero is the default setting, -4 is least 
saturated and +4 is the greatest amount of 
saturation.
	
Why would you adjust colour saturation? For 
most of your photos you will not need to. It may 
be tempting to increase the colour saturation for 
more intense colours, but be wary of doing this 
as the results often look unnatural. 
	
Photographers sometimes de-saturate colours for creative effect. They are trying to 
create a certain nostalgic look, or to make the colours more subtle. Colour is a very 
powerful visual element – it is one of the dominant compositional elements of an 
image. But sometimes it is too dominant – and by de-saturating the image you are 
letting other compositional elements such as the use of lines and tones, become more 
prominent. De-saturation suits certain subjects, such as portraits, nude studies and 
still lifes, although you are free to experiment with de-saturating any of your photos.

colour saturation 0

colour saturation -4

colour saturation +4

Colour saturation
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Your photos – as they are taken by the camera – are not sharp. The reason for this is 
that EOS digital cameras have an anti-aliasing filter positioned in front of the sensor. 
The purpose of this filter is to prevent moire patterns and smooth out diagonal lines in 
the captured image. However, in doing so it also softens the image. This means all your 
digital photographs need sharpening at some point.

Most resources recommend that sharpening should be left until the last step in 
post-processing. This is because the amount of sharpening you need to apply varies 
depending on what you are going to use the photo for. For instance, a photo intended 
for viewing on a website requires a different level of sharpening to a photo that 
is going to be printed on an inkjet printer. If you intend to submit the photo to a 
magazine or book publisher, they will ask that you don’t sharpen the image, as they 
will sharpen it themselves to a level that suits the printing process. 

However, because editing in DPP is a non-destructive process, you can re-adjust the 
sharpening levels at any time if required. Therefore it is not important to leave it until 
last. As it is grouped with the contrast, highlight, shadow and colour control sliders, 
this is the logical place to write about it. Just remember that you may need to alter the 
sharpness settings when you convert the Raw file to a JPEG or TIFF, depending on the 
purpose that you have in mind for it.

If you use the JPEG format, sharpening is applied to your photos when they are 
processed by the camera. The amount of sharpening depends on which Picture Style 
you have set. You cannot undo sharpening at the post-processing stage – although 
you can always add more if required.

 If you use the Raw format, the sharpening level is set when you select the Picture 

Sharpening in DPP

DPP offers two sharpening settings – Sharpness and  Unsharp mask. 
The Sharpness setting works on a scale from one to ten, and the 
numbers correspond with sharpness settings that you can alter under 
the Picture Style settings on your camera (where the range is one to 
seven). 

This was the only sharpness setting available until recently, when 
Canon introduced the Unsharp mask (if you don’t see this option you 
need to update to the latest version of DPP – see page 76 for details on 
how to do this).

 The Unsharp mask offers a finer control over the sharpness settings. It 
has three sliders. Strength lets you set the sharpening level on a scale 
of one to ten. Move the Fineness slider left to retain fine detail,  or right 
to increase sharpness but at the expense of fine detail. Threshold refers 
to the difference in contrast between edges. The higher the threshold, 
the greater the difference in contrast needs to be at an edge before 
DPP sharpens it. Increasing the threshold reduces the area of the photo 
that is sharpened. 

Sharpening
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Style.  You can then use the sharpness slider to increase or decrease the level of 
sharpening. This is an important difference. If you intend to edit your JPEG photos 
in Photoshop, any changes to brightness or contrast levels are applied to an already 
sharpened image. If you are unlucky, this may introduce halos or jagged lines at the 
edges of objects in your photos. 

When you are processing Raw files, sharpening is part of a non-destructive editing 
process and is only applied when the Raw file is converted to a JPEG or TIFF file. 
Changes to brightness or contrast levels in DPP will not have any adverse affects on 
the edges of the subject.

It is important to understand that sharpening doesn’t actually sharpen the photo. 
What it does is increase the appearance of sharpness by increasing contrast at the 
edges of objects within the photo. Sharpening is not a fix for poor technique – it 
cannot fix blur caused by camera shake, out-of-focus subjects, subject movement or 
image softening caused by dirty lenses, lens flare or atmospheric haze. 

The purpose of sharpening is to counter the softening effect of the camera’s anti-
aliasing filter and prepare your images for viewing on a computer screen or in printed 
form. Over-sharpening an image results in halos or jagged lines along the edges (such 
as horizons or hair) in the photo. You can look out for this in books and magazines, 
where you will sometimes spot over-sharpened images.

For most purposes, you will not need to change the sharpening level set by DPP. 
Canon recommends that you do not increase the sharpening level, as this may create 
white halos around high contrast areas of the photo. 

The advantage of using DPP to process Raw files is that you can come back to the 
photo and export a different version with a different level of sharpening if you need to. 
That is why I recommend that you stick with the default sharpening levels – if you find 
that you need to increase or decrease sharpening, it is easy to do so.

Canon Picture Styles have a sharpness setting between zero and 
four (illustrated above). This figure is the same whether you use the 
Sharpening or Unsharp mask tools. If you are using the Unsharp Mask, 
Fineness is set to 7 and Threshold to four, regardless of which Picture 
Style you select. You can then change them to suit the image you are 
processing.

When looking at the effect of sharpening on your monitor, you can only 
judge the result with the image enlarged to the 50, 100 or 200 percent 
views. If you are using the Fit to window view, DPP ‘squashes’ the image 
to fit your window size and this can affect the accuracy with which the 
edges within the image are displayed on the screen.

The default Picture Style sharpness settings are: Standard: 3, Portrait: 
2, Landscape: 4, Neutral: 0, Faithful: 0, Monochrome: 3, Nostalgia: 0, 
Clear: 3, Twilight: 3, Emerald: 3, Portrait Studio: 2, Portrait Snapshot: 2

Sharpness 0 (no sharpening)

Sharpness 4 ( landscape Picture Style default)

Unsharp mask 4 (landscape Picture Style default)
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All camera lenses suffer from some sort of image distortion or aberrations. 
When it comes to lens quality, there is always a trade-off between price and 
performance. Distortion and aberrations are minimised on expensive lenses, 
such as Canon’s top of the range L (luxury) series. Prime lenses also tend to give 
good image quality – it is easier to design a lens to perform well at a single focal 
length than along the entire focal range of a zoom lens.
	
The good news is that Canon have built a Lens aberration correction pane into 
DPP. It gives you the option of correcting lens aberrations in post-processing. It 
only works with Raw files – if you use JPEG, you are stuck with what the lens gives 
you. If you have ever had the experience of seeing chromatic aberrations on your 
images along the edges of highlights, something that can happen with any lens, 
regardless of quality, you will appreciate this benefit of using Raw files.
	
DPP cannot give a photo taken with a budget lens the characteristics of a photo 
taken with an L series lens. But it will improve image quality by correcting the 
worst elements of barrel distortion, chromatic aberration and vignetting.
	
DPP corrects lens aberrations by reprocessing the photo using a mixture of 
information stored in its database and that recorded by the camera when the 
photo was taken. DPP stores the lens optical data for over 90 lenses. The lens 
model, focal length and subject-to-focal plane distance are all stored by the 
camera when the photograph is taken. The software uses all this information to 
reprocess the image and obtain a better Raw conversion.

DPP corrects four types of lens distortion or aberration  – the photo on the next 
page, taken with a budget kit lens, has them all:

Compatible cameras

Lens aberration corrections can only be made to images shot in the 
Raw format on the following EOS cameras, fitted with a compatible 
Canon lens. If you are editing a Raw file taken with a camera not 
on the list, the Tune... button is greyed out and the Lens aberration 
correction pane is inaccessible.
	
There are currently 96 compatible Canon lenses. They are listed in 
the latest Canon DPP manual, downloadable from the Canon USA 
website at www.usa.canon.com/cusa/support/consumer. Once on the 
Canon download page, enter the model of your camera to access the 
latest instruction manuals for all Canon EOS software. 

DPP only has information for Canon lenses. If you use third-party 
lenses, the Tune button is greyed out and you cannot use the Lens 
aberration correction window. Most other Raw processors, on the 
other hand, will work with images taken with any lens. The difference 
is that they may not have specific information for the lens that you 
are using – instead, it is up to you to make corrections by eye.

EOS 1000D, 1100D, 400D, 450D, 500D, 550D, 600D
EOS 30D (requires firmware version 1.0.6)
EOS 40D, 50D, 60D, 7D

EOS 5D (requires firmware version 1.1.1)
EOS 5D Mark II

EOS 1D, 1Ds
EOS 1D Mark II, 1Ds Mark II
EOS 1D Mark III, 1Ds Mark III
EOS 1D Mark IV, 1D X

Lens correction

http://www.usa.canon.com/cusa/support/consumer
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Vignetting 
The frame is darker towards the edges than at the centre.  While it is not so 
obvious in this image, it is a feature of most lenses if you use the widest aperture 
settings. It is also common on wide-angle lenses. 

Barrel distortion 
Straight lines near the edge of the frame are bent by the lens. You can see it 
here at the platform edge and along the top of the train carriages. You get this 
with wide-angle lenses. Good quality lenses have less barrel distortion. You may 
see the opposite, pincushion distortion, with telephoto lenses. With pincushion 
distortion, lines near the edge of the frame bend inwards.

Chromatic aberration 
Colour fringing (often magenta) near the edge of the frame.

Colour blur
Blue or red colour along the edges of highlights. 

Chromatic aberration and colour blur are often a problem with backlit images 
like this one. You can see both along the edges of the tree if you look closely. 
Chromatic aberration has always been around (although digital sensors are more 
prone to magenta fringing than film) – take a look at photos taken with film cameras 
in old magazines or books and you’re bound to see some. You’ll also see it on old 
television shows – you only have to compare the image quality of a television show 
made in the seventies with a modern one to see the improvement in television camera 
lenses. 

No-one talked much about chromatic aberration in the days of film photography. 
Now, it is easy to zoom into 100 percent magnification on a computer monitor and 
see colour fringing up close. We are looking at images more closely than we ever have 
before and becoming pickier as a result. 

There is green and magenta 
colour fringing around the 
edges of the tree. Using the 
Lens aberration correction 
window will eliminate, or at 
least minimise, this type of 
fringing.
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The Lens aberration correction window
Go to the NR/Lens/ALO tab in DPP and click the Tune button to bring up the Lens 
aberration correction window.  The current settings for peripheral illumination, 
chromatic aberration, colour blur and distortion are displayed.

Shooting distance information 
The distance from the sensor plane that the lens was focused on when the photo 
was taken. DPP uses this information to assist calculating the required amount 
of lens aberration correction. The shooting distance information is only recorded 
by the following cameras: EOS 1000D, 1100D, 450D, 500D, 550D, 600D, 40D, 50D, 
60D, 7D, 5D Mark II, 1D Mark III, 1D Mark IV, 1Ds Mark III, 1D X.

The shooting distance is set to infinity by the following cameras, regardless of 
where the lens was focused: EOS 400D, 30D, 5D, 1D, 1D Mark II, 1D Mark IIN, 1Ds, 
1Ds Mark II.  If the photo was taken with a MP-E 65mm f2.8 1-5x macro or an EF 
50mm f2.5 compact macro with the Life Size Converter EF, then the slider changes 
from shooting distance information to Magnification factor.

Peripheral illumination
Corrects vignetting by lightening the edges of the photo (see page 46)

Distortion
Corrects barrel and pincushion distortion (see page 49).

Chromatic aberration and Colour blur 
Correct colour fringing at the edge of the image and colour blur at highlight 
edges (see page 50)

Reset button 
Returns Shooting distance information and PIC back to their original settings, and 
everything else back to zero.

A 200 percent enlargement 
is displayed in the top right 
when you click on an area 
within the image. Tick the 
navigator box to display a 
cursor around the point you 
clicked.

Tick the Grid box to display a grid of lines over the image. This 
helps you judge whether any straight lines are actually straight.
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PIC
Peripheral Illumination Correction (PIC) corrects the effects 
of vignetting by brightening the edges and corners of the 
image. PIC can only correct vignetting caused by the optical 
characteristics of the lens that you are using – it cannot fix 
vignetting caused by using too many filters or the wrong lens 
hood.

If PIC is enabled on your camera when you take a photo, DPP 
will use those settings when it opens the Raw file. The program 
automatically brightens the edges of the photos according to the 
information held about the lens you had mounted on the camera.

If PIC wasn’t enabled on your camera, or you have one of the EOS 
cameras listed below that doesn’t feature PIC, you need to go to 
the Lens aberration correction window and tick the Peripheral 
Illumination box. The scale runs from zero to 120 – move the slider to 
increase or decrease the strength of the effect. 

You will see the most dramatic difference 
with photos taken at the maximum aperture 
of the lens. There is less vignetting at smaller 
apertures, and you may not notice much 
difference when you activate PIC.

with Peripheral Illumination Correction

without Peripheral Illumination Correction
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You might struggle to see the difference between the two images 
on the previous page, so I’ve enlarged the bottom left corner from 
both images here so you can see the difference that using PIC 
makes.  With this particular image I prefer the uncorrected version, 
as the vignetting helps guide the viewer’s eye towards the flower at 
the centre of the photo.  

	
You may not always want to use PIC – there are times when you may wish to 
darken the edges of the photo to guide the viewer’s eye towards the centre 
of the composition. My personal preference is to darken the edges of my 
photos – this technique suits my style and I rarely use PIC. But it is there if 
you need it, or prefer to process your photos differently than I do.

Other Raw processors let you compensate for vignetting, but they may 
not hold data for specific lenses. Instead, you use a slider and judge the 
effect by eye. On these processors, you can actually increase the amount of 
vignetting for creative effect, if you wish to.
	
PIC is a fairly new feature and can only be used with Raw photos taken with 
these cameras:

EOS 400D, 450D, 500D, 550D, 600D, 1000D, 1100D 
EOS 30D (firmware version 1.0.6 or higher), 40D, 50D, 60D,
EOS 7D, 5D (firmware version 1.1.1 or higher), 5D Mark II
Any 1 series camera.

without Peripheral Illumination Correction

with Peripheral Illumination Correction
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Vignetting, and the difference that PIC makes, 
is probably clearest in photos with blue sky. The 
image on the top left shows the effect without any 
correction, and the image at the bottom shows 
the correction applied by DPP. The program set 
the slider to 66 as, according to the information 
it holds about the EF 17-40mm lens used to take 
the photo, this is the best setting to correct the 
vignetting. You can move the slider anywhere 
along the scale you like. The image above 
shows what happened when I moved applied 
the maximum amount of correction. The result 
doesn’t look natural because the sky is lighter at 
the corners than in the centre of the photo.

Without Peripheral Illumination Correction

Peripheral Illumination Correction (66)

Peripheral Illumination Correction (120)
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While all wide-angle lenses show at least some degree of distortion, better quality 
lenses are less likely to suffer from it. The example on this page was taken with Canon’s 
EF 17-40mm f4 L lens. If you compare you will see that there is much less barrel 
distortion than in the photo of a train on page 44.

Whichever Canon lens you have, the Distortion correction feature in DPP is easy to use 
and eliminates the worse of any distortion you may see in your photos. All you have 
to do is tick the Distortion box and DPP automatically applies the correction needed 
to fix any barrel distortion (or pincushion distortion if you’re using a telephoto lens). It 
may not be a perfect correction every time, but lines will certainly look a lot straighter. 
There is a slider that operates of a scale of zero to 100 so that you can decrease the 
amount of correction that DPP applied if necessary.
	
You can use the grid (tick the grid box if you don’t see it) in the Lens aberration 
correction window to help you see how straight the lines in your photo really are. 
	
Why didn’t I use the example with the train, with its higher level of distortions? I 
would have liked to, but the photo was taken with an EOS 350D and DPP won’t correct 
photos taken with this camera. If you have an older camera like the EOS 350D, it is 
worth considering buying another Raw processing program if you have images that 
could benefit from distortion correction (not all Raw processing programs support 
distortion correction – for instance, I can correct lens distortion in Lightroom 3, but not 
in the version of Adobe Camera Raw that comes with Photoshop CS 4).

This also shows another benefit of the Raw format – you can’t correct distortion in 
JPEG files. There are ways to correct distortion in Photoshop, if you have it, but they 
take a little more work. Using Raw simplifies the process.

without distortion correction

with distortion correction

Lens distortion
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Colour fringing and colour blur tend to occur towards the edges of the 
frame and around bright highlights and these are the areas of your 
photo you should look at first to see if there is any fringing. The best 
way to do so is by using the 100 per cent view option. 

DPP has two controls in the Lens correction pane for correcting 
colour fringing. Start by ticking the Chromatic aberration box – 
this will make an immediate difference. If there is still fringing, try 
ticking the Colour blur box to see if that helps. You can also try 
using the red (R) and blue (B) sliders to see if they eliminate it. Be 
careful though with the sliders though, as even if they work in one 
part of the photo, they may introduce or worsen colour fringing in 
other parts of the photo. Correcting colour fringing is sometimes a 
compromise, you may not be able to eliminate it entirely throughout 
a photo.

In the example in this page the 100 per cent view reveals red and 
green colour fringing around the edges of the building. All I had to 
do to eliminate it was tick the Chromatic aberration box, and DPP 
took care of the rest. 

without correction

with correction

Chromatic aberration
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Noise reduction
Noise comes in two forms, chrominance noise and luminance noise. Chrominance 
noise affects image colour (and looks the most unnatural), and luminance noise affects 
the brightness. 

The two principle causes of noise are shooting at a high ISO and underexposure. 
Unsurprisingly, you’ll see the most noise in underexposed photos taken at high ISOs. 
If you are using a high ISO, it is essential to get the exposure right when you take the 
photo. I encourage you to experiment with the high ISO settings on your camera. With 
careful technique, and DPP’s noise reduction function, you may be surprised at how 
good the image quality is.

The amount of noise you see in your photos also depends on which camera you have. 
Because noise is such a problem with digital cameras, Canon has worked hard to 
improve its noise reduction technology, and each generation of the Digic processors 
used in its EOS cameras provides better quality images than its predecessor. Sensor 
size makes a difference too – full frame sensors produce images with less noise than 
crop sensors. What this means is that while DPP’s noise reduction tools are very good, 
you can’t expect to match the quality of an EOS 5D Mark II with images taken by a 
camera like the EOS 300D.
	
DPP has two sliders for correcting chrominance and luminance noise. They are 
adjustable on a scale of zero to 20. The default setting is normally two for luminance 
noise and zero for chrominance noise, although these may change depending if you 
enable High ISO noise reduction in-camera.

I took this photo at ISO 3200 on my EOS 40D but made the mistake of 
underexposing it by a stop. I increased exposure and contrast in DPP 
but this also increased the noise levels, especially in the darkest areas. 

I should also point out that ISO 3200 is an extended ISO on the EOS 
40D. Extended ISOs are outside what Canon consider to be the natural 
working ISO range of the camera and you have to enable them in the 
custom functions menu. They are included so that you have the option 
of using them – but downside is that the noise levels and banding are 
very high. Do not expect to eliminate all the noise from photos taken 
at these ISO settings in DPP.
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without noise reduction

chrominance noise reduction 20,
luminance noise reduction 2

chrominance noise reduction 20,
luminance noise reduction 4

The 100 percent enlargements on this 
spread show how strong the noise 
is. Moving the Chrominance noise 
reduction slider to 20 helps reduce the 
noise, although it can’t be eliminated. 
Increasing luminance noise reduction 
to four helps a little, but the image 
starts to lose definition and it probably 
isn’t worth it. This photo shows that 
DPP’s noise reduction can’t make up 
for poor technique.
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Chrominance and luminance noise reduction
You can change the noise reduction levels by going to the NR/Lens/ALO tab and 
moving the Luminance and Chrominance noise reduction sliders. But if you do it this 
way you won’t see any change as you move the sliders as you have to click the Apply 
button before they take place.

The best way is to click the NR Preview button. This brings up the Noise reduction 
preview window, which has a square showing a 200 percent enlargement of the photo 
(move the cross around the thumbnail to enlarge a different point within the image). 
Any changes you make to the sliders will be updated immediately in the preview. 

Begin by adjusting the chrominance noise slider. Chrominance noise creates 
coloured speckles and is most visible in shadow areas. It is what gives digital noise 
an unpleasant appearance compared to the effect of visible grain you get from using 
a high ISO film. If you can eliminate chrominance noise you get an effect that is very 
similar to film grain.  The changes made by the slider are gradual, so start by setting 
the slider to 10 or 15 to see which works best, and making fine adjustments from 
there. Too much correction can lead to colour smearing and de-saturation.	  

The Luminance noise reduction slider is, with some exceptions, set to two by default, 
and in most cases that is where it should stay. The slider is very sensitive and moving 
it by a factor of even just one makes a visible difference to the photo. Increasing 
luminance noise reduction has the side effect of softening the image – you have less 
noise but you also lose detail. 

You can use this to your advantage – moving the Luminance noise reduction slider 
to one or zero has the effect of sharpening the image. You haven’t really sharpened 
it – it’s just that the default luminance noise reduction setting had softened the photo 
slightly, and now you’re seeing it without that softness. This works best at low ISOs – 
otherwise you’ll also see an increase in luminance noise that normally isn’t worth the 
gain in sharpness. Click the Apply button when you’re done to finalise the changes.

The default noise reduction settings for this image, taken at ISO 6400 
on an EOS 5D Mark II, were seven on the Luminance noise reduction 
scale and 11 on the Chrominance noise reduction scale. Seven is too 
high for luminance noise reduction, so I reduced it to two without 
adversely affecting the quality of the image.
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Canon recommends using the Auto Lighting Optimiser (ALO) for subjects like backlit 
portraits to bring out detail. The difference it makes is normally quite subtle – its 
main function seems to be to increase exposure and lift contrast, in order to counter 
underexposure caused by taking backlit photos using an automatic metering mode 
without exposure compensation. I’ve also found it useful for giving a lift to images 
taken in very flat light (for Photoshop users, it’s a little like using the auto Levels 
command).

The ALO feature is aimed at photographers using the JPEG format, to help them get 
good quality images in-camera. It’s not really a useful feature when you use the Raw 
format, as you can do the same yourself, and with more precision, using the brightness 
adjustment, contrast, highlight and shadow sliders under the Raw tab in DPP. If 
you got the exposure right when you took the photo, enabling ALO will make little 
difference to the final image.

It’s included in DPP to give you the option of using it. I don’t, but it’s always worth 
trying it to see if it makes a difference. If you have ALO enabled on your camera (see 
compatible models below) DPP automatically sets the ALO setting to the same level 
when you open the Raw file. For this reason, you may wish to go the ALO setting first 
when you open your Raw file to make sure that it’s disabled. 

The Auto Lighting Optimiser tool is a relatively new feature and can only be used with 
Raw photos taken with an EOS 500D, 550D, 600D, 1100D, 50D, 60D, 7D, 5D Mark II , 1D 
Mark IV or 1D X.

with ALO (strong)

without ALO

Enabling ALO didn’t make much 
difference to this image.  If you 
look closely, you’ll see that 
the image with ALO enabled 
has a little more contrast than 
the one without. You can see it 
most clearly at the bottom of 
the image.

ALO
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Click the Trimming angle button to bring up the Trimming/angle adjustment 
window. This window lets you trim your images so that you can crop out any 
unwanted distractions near the edge of the frame. You can also rotate the image 
before you crop – the main purpose of this is to obtain straight horizons on landscape 
photos, although you are free to rotate your photos as wildly as you want.

There are good reasons not to crop an image. One is based on the idea that, for 
maximum image quality, you should avoid cropping as a cropped image needs 
to be enlarged more to get to a certain size. While this was truer a few years ago 
when cameras had less megapixels, with today’s large megapixel counts it’s less of a 
concern. 

Another argument, this time from the creative side, is that you should be able to 
compose your image perfectly within the viewfinder when you take the photo. Henri 
Cartier-Bresson, for example, took great care in the composition of his photos and had 
a reputation for never cropping his images. However, while this is a laudable goal, I 
know I take photos that can be improved compositionally by cropping, and I’m sure 
most photographers do too.

There are good reasons for cropping too. I’ve already mentioned straightening 
horizons, and I also like to crop to improve composition. Most EOS cameras don’t have 
a 100 percent viewfinder (the only ones that do are the EOS 7D and the professional 
level 1 series cameras). This means that the area of the photo extends slightly beyond 
what you can see in the viewfinder, and it is easy  to include distracting objects at the 
edge of your photos that you weren’t aware of at the time. Cropping helps you get rid 
of these.

A background object intruded 
into the top left corner of the 
original image. It’s small, but 
still a distraction, so I cropped 
it out in DPP. This image also 
works well cropped to a square.

uncropped original

cropped

1:1 aspect ratio

Trimming angle
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Another application is that you can experiment with different aspect ratios. EOS 
cameras have an aspect ratio of 3:2 – that is, the frame is one and a half times as 
wide as it is tall (this is for photos taken in the landscape format, turn the camera 
on its side and the aspect ratio becomes 2:3 – the width is always placed before 
the height).

Within DPP, you can 
experiment with cropping 
to aspect ratios like 5:4 (used 
by large format cameras), 7:6 
(medium format), 4:3 (medium 
format and micro four-thirds), 
1:1 (medium format and toy 
cameras like Holga) and 16:9 
(panoramic format). It’s a useful 
creative exercise to go back 
through your old images and see if they can be improved by cropping.

The latest version of DPP also lets you crop your images to a circle. While I have 
no use for this myself, I’m sure that there are photographers somewhere who will 
find a use for it.

If you have an EOS 60D, 600D, 1D Mark III, 1Ds Mark III ,1Ds Mark IV or 1D 
X, you can use Live View to shoot images in different aspect ratios. With 
the 60D and 600D you can choose from 4:3, 1:1 and 16:9  and the 1 series 
cameras have more options. Select one of these aspect ratios and you’ll 
see lines on the LCD screen that indicate the borders of the image. The 
aspect ratio information is appended to the Raw file and recognised by 
DPP, which will open the file with the selected aspect ratio. None of the 
data captured by the sensor is lost though, you can go to the Trimming/
angle adjustment window to change the aspect ratio at any time.

uncropped original

cropped

cropped 16:9 aspect ratio

I took this photo from 
a bus in Argentina. The 
horizon in the original 
needed straightening, as 
it often does when you 
take photos hand-
held. I also created 
a panoramic 
version of the 
photo by cropping 
to the 16:9 aspect 
ratio. This aspect 
ratio isn’t part of 
DPP’s options, so I 
entered the figures 
as a custom setting. 
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Click the Full screen button to enter a full screen 
view, Clear to undo the current crop, and Reset to 
go back to the photo’s original state.

This is where you set the aspect ratio you wish 
to crop to. Select Free to crop arbitrarily without 
preserving a particular aspect ratio, for instance 
if you just need to trim a little off the edges to 
remove a distraction. If the aspect ratio you want 
to use doesn’t exist, you can select Custom and 
type it manually in the fields underneath the 
aspect ratio drop down menu. The fields below 
that show the ratio between the width of the 
image (x) and the height (y). If you selected an 
aspect ratio, they will correspond to that. Below 
that are the width and height of the current crop 
in pixels. When you’re ready, click and drag across 
the image with your mouse to crop. 

Use the slider to rotate the image arbitrarily or 
the Rotate left and Rotate right buttons to rotate 
it 90 degrees at a time (you can also use the 
mouse to rotate the image by pointing the mouse 
outside the photo until you see the  icon, then 
clicking and dragging).

Tick the Show borders box to see a border around 
the edge of the crop. Use the Opacity slider to 
grey out the cropped part of the image, making 
it easier to see how the cropped photo looks. You 
can tick the Show grid box to place a grid over 
the image – useful for checking the straightness 
of horizons and buildings. You can change the 
size of the grid squares with the Grid pitch slider.

When you click the Center on 
screen button DPP displays 
the largest possible trimming 
range at the current cropping 
angle and aspect ratio as a 
dashed rectangle. The guide 
won’t be displayed if the 
trimming angle is set to zero 
degrees.

Use the Copy and Paste buttons to copy 
the crop settings from one photo and 
paste them to another. Use the Apply 
All button to paste the crop settings to 
multiple images – you need to select 
the images in the Main window first. 
You can access the Trimming/angle 
adjustment tool from either the Main or 
Edit windows, and use the Previous and 
Next buttons to navigate between the 
selected images.
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Recipes
When you edit a Raw file, the changes that you make to it are stored in what DPP calls 
a recipe. This means that you can go back to the Raw file at any time, and DPP looks at 
the recipe when you open it to see what changes you have made to the file. The recipe 
is appended to the Raw file, so the two never get separated. The recipe is the key to 
the non-destructive nature of editing with DPP – it allows you to make changes to Raw 
files without overwriting or discarding any of the original data.

Where DPP gets really clever is that it lets you apply the recipe from a single Raw file 
to other Raw files. The advantage is that if you have a series of photos that are similar 
(for example a series of landscape photos take of the same subject at the same time of 
day) you can edit one Raw file, then apply the settings that used to all the other photos 
in the series. The other photos then need only minor tweaks to finish them off. This can 
save you a lot of time.

There are two ways to use Recipes. The first is to go to Edit > Copy recipe to 
clipboard. Then, select another photo and go to Edit > Paste recipe to selected 
image (you can select more than one image when you paste). This works in both the 
Main window and Edit image windows. 

The second option is to save the recipe as a file (Edit > Save recipe in file). This is the 
sort of thing you might do if you were taking the same type of photo over and over, 
such as in a studio. You can open and apply the saved recipe to Raw files at any time by 
going to the Edit > Read and paste recipe from file.

The recipe that you paste to other Raw files contains the adjustments that you have 
made within the Raw, RGB and NR/Lens/ALO tabs of the Tool palette. It doesn’t 
include any changes made with the Trimming/angle adjustment or Stamp tools. 

The RGB tab

Click on the RGB tab and 
you will see more sliders for 
adjusting brightness, contrast, 
hue, saturation and sharpness. 
This is confusing because 
these sliders already exist 
under the Raw tab. So why are 
they here?
	
The RGB tab is designed for 
adjusting JPEG and TIFF files, 
not Raw. If you were to edit a 
TIFF or JPEG file, the sliders 
under the Raw tab would be 
greyed out and you would 
have to use the sliders under 
the RGB tab.
	
You can still use the RGB 
sliders with Raw files 
though, although it is not 
recommended (the only 
exception is for some black 
and white work – see page 
64). You should use the Raw 
tab, and only go to the RGB 
tab if the effect from the Raw 
sliders is not strong enough. 
In practise, this is unlikely. 



p. 59
59

DPP makes it easy to switch to Photoshop to continue editing the photo that you are 
working on. Go to Tools > Transfer to Photoshop – DPP exports the Raw file and 
opens it as a 16 bit TIFF file in Photoshop CS. Here you can make further edits and save 
the file as a new image to your hard drive. 

Linear
Tucked away under the Shadow slider is a tick box with a function that doesn’t seem 
to make much sense. If you tick the Linear box, the image goes dark and it’s not clear 
what is happening or how it could be useful. What you’re actually seeing is version of 
the image with an adjusted curve that maximises highlight detail. You can transfer it to 
Photoshop, along with a copy of the photo processed for the mid-tones and shadows, 
and blend the two together using layer masks. You can also use the image created with 
the Linear box as part of sequence for creating a High Dynamic Range (HDR) image.

The process is quite easy, especially if you’re proficient in Photoshop. Start by 
exporting a copy of your edited photo to Photoshop. Then tick the Linear box, and 
export another copy – it opens in a separate window.  In Photoshop, copy the second 
version and paste it over the first. You can then just erase the area of the top layer that 
you don’t need, or better still, make a selection over the area you want to retain, use 
the Refine Edge tool to feather it and turn it into an editable layer mask by clicking the 
Add layer mask icon at the bottom of the Layers palette.

blended image

linear box ticked

linear box unticked

This technique maximises detail in 
the sky in landscapes like this one. 
Edit your Raw file and transfer it to 
Photoshop, then tick the Linear box 
and transfer this image to Photoshop 
too. Here I used a layer mask and 
levels and contrast adjustments to 
blend the two images to create a 
natural looking photo.

Transfer images
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It wasn’t that long ago that black and white photography required a darkroom – and 
the only options were to build one or use someone else’s. Thanks to the expense and 
inconvenience, you had to be quite serious about black and white photography to do 
this. It also takes a long time, and a lot of practise, to learn to make a good black and 
white print.

Not any more – digital photography has brought black and white photography to the 
masses. What’s more, if you shoot Raw, thanks to the non-destructive nature of DPP 
you still get to retain the original image in all it’s colourful glory should you ever need 
it. You can also go back through your photo collection and see if any of your images 
would make good black and white images. Using Raw, and converting your images to 
black and white in DPP gives you far more control using the monochrome Picture Style 
and shooting JPEG files. 

You’ll be surprised at how good DPP is for black and white photography. But don’t 
expect DPP to give you nearly as much flexibility for converting your Raw files to 
black and white as programs like Lightroom, Photoshop Elements or Photoshop CS. 
If you are serious about black and white photography, at some stage you will want to 
purchase a more sophisticated Raw processor or image editing program.

The monochrome Picture Style, on its own, won’t give you a great black and white 
conversion, but you can improve the result by tweaking the Contrast, Highlight and 
Shadow controls. You will probably find that you need to increase the contrast a lot, as 
colour images tend to look flat when you convert them to black and white. The photos 
on the right are a good example. The initial conversion needed a big lift in contrast, 
but the improvement is dramatic.

standard Picture Style

monochrome Picture Style

monochrome Picture Style 
contrast +4, highlight +1, shadow -5

Black & white
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The single dominant element in just about any colour photo 
is, naturally enough, colour. No matter what the content, you 
can’t seem to get away from the colours within the image. If the 
photographer did his job well, the colours will be strong, powerful 
and create an emotional response. Unfortunately, colour also pulls 
attention away from all the other compositional elements of the 
image. It’s a distraction.

What happens when you strip away colour to make a monochrome 
image? You are left with the building blocks of photographic 
composition: such as line, pattern, texture, tonal contrast and the 
use of light. These are the things that black and white photographers 
use to create dramatic, eye-catching black and white photos. 

If you’re new to black and white photography it takes time to see 
these things and use them wisely in your images. But it’s a good 
skill to practise because the things you learn along the way will ultimately 
benefit your colour photography too. Black and white photography is also 
fun – there are new techniques to try. Follow the steps on these pages and 
you’ll be rewarded with some beautiful black and white photos.

Why mono?

One photo, two interpretations – one colour 
and the other black-and-white. The black-and-
white photo draws attention to the structure 
of the lizard’s skin, and the contrast between 
its head and the background. The colour photo 
is dominated by the colour green and evokes 
the lushness of the animal’s environment.
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There is more to converting to black and white than switching to the monochrome 
Picture Style and increasing contrast. DPP also has four coloured filters that you can 
use to change the nature of the black and white conversion.

What do coloured filters have to do with black and white photography? DPP has four 
– red, orange, yellow and green. If you’re new to black and white photography you 
may be surprised to learn that coloured filters are an essential tool for black and white 
film photographers. The filter is used on the camera lens when the photo is taken to 
change the tones recorded by black and white film. 

Coloured filters lighten some tones and darken others. A red filter, for example, 
prevents blue lightwaves from entering the lens, giving the photo (if it were taken in 
colour) a red colour cast. In black and white this has the effect of making blue tones 
darker (because less blue light waves enter the lens, effectively underexposing blue 
subjects) and red tones lighter (because more red light waves enter the camera lens, 
effectively overexposing red subjects). 

In practice, this makes blue skies quite go dark, which is one of the reasons that black 
and white film photographers like red filters. Take a look at the example on the right 
to see what I mean – the blue sky, already darkened by using a polarising filter, goes 
very dark when the red filter is applied during the black and white conversion. If the 
sky is too dark for you, the yellow and orange filters have a similar effect, but aren’t as 
strong and don’t darken the sky so much. Green filters lighten green subjects and help 
in creating tonal contrast in predominantly green subjects (the effect of these filters is 
shown on the next page – look at the difference in tone of the red wall and dark green 
shutter on the left to see how the coloured filters change the tones).

landscape Picture Style

monochrome Picture Style
red filter

Converting to b&w
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The colour filters in DPP have the same effect on your black and white conversion as 
their glass equivalent do on black and white film. The benefit of DPP is that you don’t 
have to think about using coloured filters in the field. You have the luxury of waiting 
until you process the image to decide which, if any, filters to use. It is always worth 
running through the coloured filters when you make your conversions, so that you 
can pick the one with most pleasing effect for you.  You can fine tune the effect by 
going to the Colour temperature setting and moving the Kelvin slider left or right – the 
tones in your monochrome image change as you alter the colour temperature of the 
underlying colour photo.

monochrome Picture Style
orange filter

monochrome Picture Style
yellow filter

monochrome Picture Style
green filter
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Digital toning
Earlier I talked about colour evoking an emotional response in the viewer. Does that 
mean that black and white images lack emotion? Not at all – furthermore you can 
actually add colour back in to black and white photos by toning them. This is not a 
contradiction in terms – what you are doing is using colour to create a feel for the 
image. The trick is to do it with subtlety so that the toning effect doesn’t overwhelm 
the other qualities of the black and white image.

Toning originated in the chemical darkroom, where black and white printers used it to 
increase the life-span of their prints. Sepia, gold and selenium chemical toners extend 
the life of black and white prints by replacing the silver in the print with another metal 
that is more resistant to light and other environmental factors that cause fading.

Toning has no archival benefits in the digital darkroom, but you can use it for aesthetic 
purposes. Sepia toning, for example, add warmth to a black and white image (it’s a 
good way of enhancing black and white portraits). Blue toning does the opposite. It 
imparts a cold feel to the print – therefore would be a good technique to use if you are 
taking photos of something cold like a wintery landscape. Not every image benefits 
from toning, but it’s surprising how many do, and I tone most of my black and white 
images.

There are four present tones in DPP – sepia, blue, purple and green. You may have tried 
them in the past and been put off by the result – used by themselves they tend to give 
over-saturated, washed out looking results. The trick is to increase the contrast of the 
image and reduce the saturation of the toning effect at the same time. You can do this 
by going to the RGB tab and moving the saturation slider to the left – setting it to 
around 50 creates a much more subtle effect, as you can see in these photos on these 
pages.

monochrome Picture Style
sepia tone saturation 100

monochrome Picture Style
sepia tone saturation 50
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monochrome Picture Style
green tone saturation 50

monochrome Picture Style
green tone saturation 100

monochrome Picture Style
blue tone saturation 50

monochrome Picture Style
blue tone saturation 100

monochrome Picture Style
purple tone saturation 50

monochrome Picture Style
purple tone saturation 100

65
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The toning presets are a good way to start toning but they 
are limited to the four variations provided plus any changes 
you can make by changing saturation. There is an alternative 
that lets you create a much wider variety of tones – and even 
experiment with split toning. It’s an easy process to learn and 
involves using the curves tool under the RGB tab. 
	
The technique works because DPP lets you adjust the curves 
of the three colour channels that make up the photo. 

Sepia tone
Go to the RGB tab and look at the tone curve. Click on the the 
R to activate the red channel and move the red tone curve 
upwards. The result is that the photo now has a red tone. The 
more you drag the red curve upwards, the greater the effect. 

Now click on the B to activate the Blue channel, and this time 
drag the blue curve downwards. Darkening the blue channel 
produces a yellow tone, which combined with the red tone 
creates sepia. You can experiment with these two curves to 
create different sepia tones. You can also use the saturation 
slider to increase or decrease the strength of the tone.

Toning with curves
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More tones
You can use the curves to create a wide range of tones. For instance, moving the 
blue curve upwards gives a blue tone, and pulling the green curve down creates 
a purple tone.

Split toning
You can take the technique a step further 
and split tone the image.  Split toning is a 
technique where you tone the shadows one 
colour, and the highlights another. A common 
combination in the chemical darkroom was 
blue and copper – blue toning for the shadows 
and copper for the highlights. The effect is easy 
to reproduce in DPP using the red curve. Click 
on the R to activate the red curve, then click in 
the centre of the red line. This adds a square to 
the curve. Now grab the curve with the mouse 
about three-quarters of the way up and move 
it gently upwards. The top half of the curve 
moves upwards, and the bottom half moves 
downwards, pivoting around the square in the 
centre of the curve.

The top half of the curve represents highlights – 
you have added red to them by moving the top 
upwards. The bottom half represents shadows 
– you have taken red away here, turning them 
blue. The photo on this page was toned with 
this technique.
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Whatever you intend to do with your photos, at some point you will need to convert 
the Raw file to a format that other programs can understand. 

JPEG or TIFF?
The two most widely used formats are JPEG and TIFF. Here is an outline of the main 
differences between the two:

The TIFF format used by DPP is an uncompressed file format. You should use this 
setting if you want to edit the photo in a program like Photoshop CS or Photoshop 
Elements. You can open and close a TIFF file as many times as you wish without losing 
detail.

You can covert the Raw file to either an eight bit or 16 bit TIFF. Use 16 bit if you intend 
to edit the photo in Photoshop CS – this will help you get the maximum image quality 
from the file. Most other photo editing programs only edit eight bit files, so you can 
save the file as an eight bit TIFF if you will edit it in any other software.
	
The only disadvantage of TIFF files is their size. A 16 bit TIFF file from an EOS 5D Mark II 
is approximately 120MB in size. An eight bit file is half that size – around 60MB. These 
files take up a lot of hard drive space and are unsuitable for sending by email. One 
solution is to convert the Raw file to a 16 bit TIFF for editing in Photoshop CS, then to 
save it an eight bit TIFF or high quality JPEG once you have finished editing it.
	
JPEG files are compressed and therefore much smaller than TIFF files. Because of the 
compression you run the risk of losing a little of the quality every time that you open 
and resave a JPEG file. However, in practise the quality loss is imperceptible at first and 
is only likely to become an issue if you open and resave the file a number of times. 

Creating files for the internet

If you intend to display your 
photos online, you won’t need 
to create a full size photo file. 
Instead, you should resize 
the photo to make a small 
file for websites to display. If 
you are sending photos by 
email to people who don’t 
need the full size version, it 
is good practise to downsize 
your images the same way. 
Smaller images are much 
quicker to send and for the 
recipient to download.

Photos displayed online 
should be saved in the JPEG 
format at a resolution of 
72dpi. In the Convert and 
Save window, go to Resize 
setting and tick the Resize box. Set the longest side of the 
photo to 800 pixels. As long as the Aspect ratio box is ticked, DPP sets 
the other dimension to match. 800 pixels is a general size suggestion, 
you can go larger to 1000 pixels, or smaller to 600 pixels, although 
you won’t want to make your files any smaller than this otherwise they 
will be too hard to see on the screen (if you come across instructions 
to make your files smaller than this, they are probably outdated, from 
when monitor resolutions were lower than today). Click the Save 
button when you’re ready to complete the process.

Converting files
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JPEG files are eight bit files, which means that they are not as suitable for 
editing in Photoshop CS as TIFF files. Because of the small file size, JPEG is the 
ideal choice if you don’t intend to do any further editing to the file after the 
conversion.
	
The relatively small size of JPEG files means they are ideal for sending by email. 
If you want to display your photos on the internet, you will also need to use the 
JPEG format. 

Convert and save
Go to File > Convert and save. You can access this from the both the Main 
window and the Edit image window. If you are in the Main window, you need to 
select the photo you want to convert first, otherwise the Convert and save option 
will be greyed out. These are the required settings:

File format: Choose from JPEG and TIFF. You also have the option of exporting 
both JPEG and TIFF files simultaneously if you need to. 

Output setting: Set output resolution to 300dpi (the standard for photo quality 
reproduction) unless you intend to display the photo on the internet, in which 
case set it to the internet standard of 72dpi. Make sure the Embed ICC profile 
box is ticked, so that other programs know which colour profile to assign to the 
photo.

Resize setting: Leave this box unticked unless you intend to resize the photo. 
You can make the photo either bigger (if you need to make a large size print, 
for instance) or smaller (for display on the internet or to create a smaller file for 
sending by email). 
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Processing and converting files one at a time is a slow process. You can speed it up 
using DPP’s batch processing facility. The concept is very simple. Start by editing a 
selection of photos in DPP (you may use recipes to speed up the process). When you’re 
finished editing you can select all the photos you want to convert to JPEG or TIFF files 
and process them in one go, saving a significant amount of time. Batch processing 
benefits anyone who needs to process large numbers of photos quickly, including 
professional photographers.

Select the Raw files you want to convert and go to File > Batch process to open 
the Batch settings window. This works from both the Main window and Edit image 
window (you can also click the Batch process button on the Toolbar in both windows). 
	
The Batch settings window is similar to the Convert and save window but it does have 
a couple of extra options.  The first is an option to give the photos a new file name. 
You can either set it to keep the current file name or assign a new file name to the 
converted images. 
	
You can also tick the Open image using software box to open the photos in  another 
photo editing program afterwards. Click the Browse button to choose which editing 
program to use.

Batch processing
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Whenever you edit your photos it 
may be useful to see both a before 
and after version of the image side-
by-side so that you can the effect 
that the changes you make have 
had. DPP allows you do to that quite 
easily.
	
In the Edit image window,  go to 
View > Before/after comparison. 
Use the Change up/down/left/
right option below this menu entry 
to set the display. You can display 
two images side by side, or split the 
image in half so that one side shows 
the unprocessed version (see the 
images on this page for examples). 
To turn the before/after comparison 
off, just go back and click on the 
same menu option. 

Before & after
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The stamp tool is for applying dust delete data or manually eliminating dust 
spots caused by a dirty sensor. 

Dust delete data
If you have a camera with the dust delete data function, you can activate 
it withing the Stamp tool in DPP (see your camera’s instruction manual for 
details on how to capture dust delete data). DPP is the only Raw processor that 
recognises your camera’s dust delete data.

You can get to the Stamp tool by clicking the Stamp icon in the Toolbar in either 
the Edit image window or Main window. Click the Apply Dust Delete Data 
button to apply the dust spot data captured by the camera.  The dust spots in the 
image should all disappear. If any remain, you can delete them manually.

Manual dust spot deletion
You can use the Stamp tool for images that don’t have Dust delete data attached, 
or for deleting any spots that the Apply Dust Delete Data button missed. Start 
by going to the Stamp tool and double-clicking on a dust spot to go straight to 
the 100 percent view (or click the 100% button at the top). 

If the spot is dark (dust spots always are) click the Repair (Dark) button. A green 
circle appears – you can adjust the radius with the slider in the Stamp window 
or Ctrl-click to use the scroll wheel on your mouse. Click on the dust spot and it 
disappears as DPP repairs it automatically. If the dust spot isn’t erased right away, 
you can keep clicking until it disappears. You can keep doing this if there are 
other dust spots – just hold the space bar down and click and drag to move to 
another part of the photo.  

The changes you make to the image with the Stamp tool aren’t permanent – DPP 
remembers what you did so that you always have the option of reverting to the 
original image. You can undo dust spot removal within the Stamp tool window with 
the Undo button. Press < to undo the last action or << to undo them all. Don’t worry 
if you press the wrong button mistake – there are also two Redo buttons. You can also 
use the F and B buttons on the keyboard to ‘scroll’ through the dust spots you erased 
at 100 percent magnification to examine the photo in detail (B takes you backwards 
and F takes you forwards).

Cloning with the Stamp tool 
To use the Stamp tool for cloning start by double-clicking the area of the image you 
wish to clone out to go to a 100 percent enlargement. Click the Select copy source 
button and click on the part of the image you want to copy from. Then click on the 
part of the image that you want to clone out. You can keep the mouse button down to 
clone a large area. You should note that the Stamp tool functions purely as a cloning 
device – there is no blending function like you get with Photoshop’s healing brush. 
This means that cloning in DPP isn’t really an option – at least if you desire a realistic 
looking result – as the example above demonstrates. If you need a good cloning tool, 
you need to use either Photoshop CS or Photoshop Elements.

Stamp tool
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Conclusion
The idea for Understanding DPP came when I was researching an article about Digital 
Photo Professional and I realised that a detailed guide to the software didn’t exist. Now 
that DPP has evolved into a genuinely useful program, I though it was time to create 
the guide that I needed when I was researching that article. 

I set out to show you how to process your Raw files within DPP, and make it clear 
that DPP is an excellent Raw converter. At the same time I didn’t want to make any 
false claims about the software, and so along the way I’ve pointed out where you 
may benefit from a more advanced Raw converter, such as Adobe Lightroom 3 (the 
software that I use most often). I hope I’ve achieved that, and helped you get the most 
out of this excellent piece of free software.

If you have any feedback on this eBook I’d love to hear from you. I enjoy connecting 
with my readers and you can find me at my blog and the websites listed below.

Andrew S Gibson
Shanghai, China
December 2011

andrewsgibson.com/blog

facebook.com/andrewsgibson

twitter.com/andrewsgibson

500px.com/andrewsgibson

flickr.com/magicalplaces
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Confucius Temple, Shanghai
EOS 5D Mark II, EF 85mm f1.8 lens, 
1/90 second at f4.5, ISO 800
DPP Brightness 0.33, white 
balance 5600K, Picture Style 
portrait, contrast 1, highlight 0, 
shadow -1, colour tone 0, colour 
saturation -4, sharpness 2  

http://www.andrewsgibson.com/blog
http://www.facebook.com/andrewsgibson
http://www.twitter.com/andrewsgibson
http://www.500px.com/andrewsgibson
http://www.flickr.com/magicalplaces
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The Evocative Image

How do you create images that 

capture the atmosphere or 

show the beauty of something 

that you perceived at a 

particular time and place? This 

ebook explores the three key 

concepts that will help you 

create evocative images – light, 

colour and composition.

My ebooks at Craft & Vision

The Magic of Black & White: 

Part I – Vision The first step 

to working in monochrome is 

learning to see in black & white. 

This ebook is split into three 

sections: composition, lighting 

and subject. You’ll learn how 

to see in monochrome, and 

why black & white is such a 

beautiful medium for creative 

self-expression.

The Magic of Black & White: 

Part II – Craft  I explain how 

I process my black & white 

photos step by step using 

Photoshop CS and Photoshop 

Elements. I guide you through 

the transformation process that 

starts with a colour photo and 

ends with a beautiful, toned 

black & white image.

The Magic of Black & White: 

Part III – Nine Photos In this 

ebook I take you through nine 

black and white images with 

the intention of explaining the 

more advanced Photoshop 

& Photoshop Elements 

techniques behind them.  I also 

explore the topic of aligning 

creative vision with post-

processing techniques.

p. 74
Click on the ebook covers 
or links (in red) to go 
straight to the Craft & 
Vision website at 
 www.craftandvision.com

Beyond Thirds

In this ebook I explore concepts 

like balance, energy, aspect 

ratios, exploiting multiple 

focal points and how you can 

improve your colour images 

by learning to see in black 

and white.  You’ll learn how 

to improve your composition 

by going beyond the rule-of-

thirds.

http://craftandvision.com/books/the-evocative-image/
http://craftandvision.com/books/the-magic-of-black-and-white-part-i/
http://craftandvision.com/books/the-magic-of-black-and-white-part-ii/
http://craftandvision.com/books/the-magic-of-black-and-white-part-iii/
http://craftandvision.com/books/the-magic-of-black-and-white-part-i/
http://craftandvision.com/books/the-magic-of-black-and-white-part-i/
http://craftandvision.com/books/the-magic-of-black-and-white-part-ii/
http://craftandvision.com/books/the-magic-of-black-and-white-part-ii/
http://craftandvision.com/books/the-magic-of-black-and-white-part-iii/
http://craftandvision.com/books/the-magic-of-black-and-white-part-iii/
http://craftandvision.com/books/the-evocative-image/
http://craftandvision.com
http://craftandvision.com/books/beyond-thirds/
http://craftandvision.com/books/beyond-thirds/
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DPP is supplied on the CD that comes with your EOS camera. The software is free, and 
so are any updates, which means you will always have the right software to process 
your Raw files.

Canon regularly updates DPP so that it recognises the files from the latest EOS cameras 
and also to include new features. Canon normally releases an update some time after it 
announces a new camera – it is always worth updating the software in case any useful 
new features have been added in addition to updates specific to the newest cameras.
	
If you have not already installed DPP, start by putting the software CD into your 
computer’s CD-Rom drive and following the onscreen instructions. Once you have 
installed it, you can confirm which version you have by going to the menu. Go to Help 
> Version information (Windows) or Digital Photo Professional > About (Mac) to 
see which version you have. If you do not have the latest version (3.10 at the time of 
writing), you can download an update from http://software.canon-europe.com 
	
Select your camera, operating system and language and look for the Digital Photo 
Professional Updater. Canon only provides updates on its website – you first must have 
installed the full version from the CD supplied with the camera for the update to work.

	
If you have lost the software 
CD or it is damaged, there is a 
workaround. Canon Japan has 
a copy of an early version of 
DPP for the Windows operating 
system that you can download 
for free at http://web.canon.jp/
Imaging/sdl/data/dpp100-e.
exe. Once it is installed, you can 
go to http://software.canon-
europe.com/ to download the 
latest version of DPP for your 
camera.
	
Mac users are not left out – you 

can download an early version of DPP at http://web.canon.jp/imaging/sdl/data/
dpp100-e.hqx and use the same process to update the software. The download 
is a compressed file with the .hqx extension, which you can open with the StuffIt 
expander, a free utility available from the Apple App store.

If you are an Adobe Photoshop or Lightroom user, and you are thinking 
about buying a new EOS camera, you should check whether the Raw 
processor in your Adobe software has been updated to recognise the Raw 
files from the camera you are thinking about purchasing. For example, 
Adobe Photoshop CS 4 doesn’t recognise Raw files from the latest EOS 
cameras – you have to update to Photoshop CS 5. 

Updating DPP

http://software.canon-europe.com
http://web.canon.jp/Imaging/sdl/data/dpp100-e.exe
http://web.canon.jp/Imaging/sdl/data/dpp100-e.exe
http://web.canon.jp/Imaging/sdl/data/dpp100-e.exe
http://software.canon-europe.com/
http://software.canon-europe.com/
http://web.canon.jp/imaging/sdl/data/dpp100-e.hqx
http://web.canon.jp/imaging/sdl/data/dpp100-e.hqx
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Monitor calibration is a confusing topic, and if you search online  you will find lots of 
misinformation. There are websites and forums where people say that you don’t need 
to buy a monitor calibration tool, or that you can calibrate with software or by eye. 
None of this is true – I’ve yet to see a software solution that works, and your eyes can’t 
detect colour casts accurately – only a machine can do that.

But it doesn’t have to be complicated. 
All you need to know is that you MUST 
calibrate your monitor, and that it’s easy 
to do as long as you buy a special monitor 
calibration tool called a colorimetric device 
(these are made by manufacturers like Eye-
One, ColorMunki, Pantone and Spyder).  

What happens if you don’t calibrate your 
monitor? Well, your monitor, as purchased 
from the shop, has a strong blue colour 
cast. Everything you look at on the monitor 
has a blue cast, although you probably 
won’t realise this until it is pointed out 
because your eyes are so good at adjusting 
to different colours. Every photo you edit 
on an uncalibrated monitor is too warm 
– because you are warming up the image 
when you adjust colour to compensate 
for the screen’s blue cast. You may also 
have trouble with contrast and brightness 

– and you’ll never manage to get a print that matches what you see on the 
screen. The bottom line is this – you will never get accurate colour from an 
uncalibrated monitor.

Calibrating your monitor is easy. All you need to do is buy a monitor 
calibration device. I use one made by Spyder – they start at around £60, and 

even the least expensive models are accurate enough for 
most photographers. Calibrating your monitor is as simple as 
connecting the device to your computer, starting the software 
and following the on-screeen instructions. The software 
that comes with it displays a series of colour patches on 
the monitor, which are measured in turn by the device. The 
software measures the difference between what the monitor 
displayed, and what it should have displayed, and creates a 
colour profile that corrects any inaccurate colours.

When you’re done, the program shows you a comparison of 
before and after the calibration process. If you’ve never seen 
this before, you’ll be surprised by how different they are. The 
program saves a profile to your computer that programs like 
DPP can use to render colour accurately on your monitor.

After the initial calibration you need to repeat the process 
every month or so (maybe even more often if accurate colour 
is of high importance to you). This is because monitor colour 
slowly drifts – so you need to recalibrate to ensure that the 
colours on your screen haven’t changed. 

Monitor calibration
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Jargon buster: some essential terms and settings

White point 
The brightest white your monitor can display. The recommended 
white balance setting for the white point is 6500k (sometimes 
called D65). But if you have an LCD monitor leave the white point 
at its native setting as this preserves the monitor’s maximum 
colour range.

Native white point  
The white point of the monitor before calibration. The native white 
point of most LCD monitors is 6500K. The native white point of CRT 
monitors tends to be higher. 

Black point 
The darkest black your monitor can display. 

Gamma 
Tells the monitor how to display mid-tones. The recommended 
setting for both PCs and Macs is 2.2.

Luminance 
The monitor’s brightness. A brightness level of around 120 
candelas is recommended for photographic editing, but not all 
monitors can be set this low. This is a starting point and you can 
change it if it doesn’t work for you. The recommended setting for 
laptops is 90 candelas as most laptops cannot achieve a brightness 
of 120 candelas.

Once you have calibrated your monitor, you need to tell DPP to use the new 
profile that you have created. Go to Tools > Preferences on a PC or Digital Photo 
Professional > Preferences on a Mac and click on the Colour management tab. Set 
‘Default settings of Work Colour space’ to sRGB and ‘Colour matching settings’ to 
Monitor profile. Click OK when you are finished.
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At this stage of the eBook I hope you have realised that Canon’s Digital Photo 
Professional is a very capable and powerful Raw processor. It may well be the only Raw 
processor you ever need. But it is also possible that you want to explore the potential 
of other Raw processors. Adobe’s Photoshop CS has a powerful Raw processor, which 
is shared by Adobe Lightroom. Capture One Pro 6  is another excellent Raw processor, 
as are Bibble 5 Prom DxO Optics Pro and Apple’s Aperture if you have a Macintosh 
computer. 
	
With some of these programs, you are paying for much more than just a Raw 
converter. Adobe Photoshop CS and Photoshop Elements are image editing programs 
as well as Raw converters. Lightroom, Aperture, Capture One Pro 6 and Bibble are 
image cataloguing programs as well as Raw converters. Here is a rundown of what 
each program does:

Adobe Photoshop CS
Photoshop CS is a powerful image editing program aimed at professional users such 
as photographers and graphic designers. At the time of writing, the most recent 
version is CS 5. It comes with Adobe Camera Raw (ACR), an extremely powerful Raw 
converter (latest version 6.2). Earlier versions of Photoshop CS use earlier versions of 
ACR, which are still powerful but lack the full feature set of the most recent version. 
Photoshop CS is the most powerful image editing and Raw conversion package 
around – which is reflected in its retail price. Learn more at www.adobe.com/
products/photoshopextended.html

Adobe Photoshop Elements
Photoshop Elements is a scaled down and much less expensive version of Photoshop 
CS. It lacks some of the more advanced image editing abilities of Photoshop CS such 

Adobe camera Raw in Photoshop CS 4. The latest versions of most Raw 
processors let you adjust aspects like exposure, contrast, sharpness 
and colour locally. This means that you can make adjustments to parts 
of an image that you select, without affecting the rest of the photo. In 
DPP, any changes you make are applied to the entire image, and it is 
not possible to edit just one part of a photo. In the example above, I 
used the Adjustment brush tool to lighten the lizard’s eye. 

DPP is a good Raw converter, but it has very limited editing capability 
when it comes to JPEG and TIFF files. Realistically, if you want to edit 
your JPEG and TIFF files, you will buy image editing software. The 
two most popular programs are Adobe Photoshop CS and Adobe 
Photoshop Elements.

Comparing DPP

http://www.adobe.com/products/photoshopextended.html
http://www.adobe.com/products/photoshopextended.html
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as 16 bit editing and the black and white conversion tool. It also comes with a scaled 
down version of Adobe Camera Raw that lacks the ability of local image adjustments. 
The most recent version is Elements 10, the details are here: www.adobe.com/
products/photoshopel/

Adobe Lightroom
Lightoom is a relatively new program that has gained popularity amongst 
photographers because it is a superb Raw conversion program and much less 
expensive than Photoshop CS. It uses Adobe Camera Raw and has full Raw processing 
capability including local adjustments. Unlike Photoshop CS and Photoshop Elements, 
it is not capable of extensively editing TIFF and JPEG files. You will need another 
program if you want to edit your images.

The main advantage of Lightroom compared with Photoshop CS is that you can edit 
a large number of Raw files and convert them to TIFF or JPEG files in one batch (you 
can do the same in DPP). This can save a lot of time in the editing process. Lightroom is 
also an image cataloguing program that creates a searchable catalogue of the photos 
stored on your hard drives.  There is more information about Lightroom 3 at www.
adobe.com/products/photoshoplightroom/

Apple Aperture
Aperture is very similar in functionality to Adobe Lightroom, except that it is made 
by Apple for Apple computers only. The interface will not be familiar to Photoshop 
users, but it will be quite easy for anyone to get used to who uses iPhoto, the image 
editing software that comes with any recently purchased Apple computer.  For more 
information, go to www.apple.com/aperture/

Phase One Capture One Pro 6
Capture One Pro 6 is another excellent Raw converter. It has a good reputation and 
was created by Phase One to go with their medium format camera backs, and is 
therefore aimed at professional photographers along with the advanced functionality 

they require. A less expensive version, Capture One Express 6, is also available for those 
who do not need the full feature set of Capture One Pro 6. You can learn more at www.
phaseone.com/4/

Bibble
Bibble, produced by Bibble Labs, is a fast Raw processor and digital asset management 
application. An interesting features is the use what Bibble call ‘layers and regions’ to 
make localised adjustments to the Raw file. The cataloging aspect is quite extensive, 
with the option to sort or search your photos by criteria such as keywords, date or 
camera settings.  There is more information about Bibble at http://bibblelabs.com/
products/bibble5

DxO Optics Pro
The main difference between DxO Optics Pro and the other Raw converters discussed 
here is that DxO Optics Pro uses data specifically created by testing each camera 
model that it supports to reduce noise and get the best out of the Raw file. It also 
corrects lens aberrations automatically during the conversion process. According 
to the manufacturer, DxO Optics Pro gives a two stop gain in noise performance 
compared to other Raw conversion applications. You can find out more at www.dxo.
com/us/photo/dxo_optics_pro/raw_conversion 

Try before you buy
With so many Raw conversion applications for sale, you’d be forgiven for feeling 
confused about the best one to buy. The manufacturers of each program listed here 
allow you to test their products by providing trial versions on their websites. My 
advice is to wait until you’re comfortable with DPP before you try another product, so 
that you can objectively compare the features. All of them are good and the decision 
about which one to use is  very personal. Most photographers will find that they 
have a preference for one of these programs over the others. You may also find that 
you are perfectly happy with DPP, and feel no need to buy another Raw processing 
application. There is nothing wrong with that – DPP is an excellent program. 

http://www.adobe.com/products/photoshopel/
http://www.adobe.com/products/photoshopel/
http://www.adobe.com/products/photoshoplightroom/
http://www.adobe.com/products/photoshoplightroom/
http://www.apple.com/aperture/
http://www.phaseone.com/4/
http://www.phaseone.com/4/
http://http://bibblelabs.com/products/bibble5
http://http://bibblelabs.com/products/bibble5
http://www.dxo.com/us/photo/dxo_optics_pro/raw_conversion
http://www.dxo.com/us/photo/dxo_optics_pro/raw_conversion

